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Part One

Background

Introduction

BigFix Web Reports is a web application. It connects to one or more BigFix Enterprise databases,
analyzes the data gathered from these databases, and provides a visual display of the data.

Audience

This guide is intended for users of the BigFix Web Reports application. Most users will be
interested in generating and printing out reports, but some users will be authorized to generate
new custom reports.

This guide encompasses all the features of the Web Reports Interface. Advanced topics in
relevance and the low-level report language are beyond the scope of this document. For more
information on these topics, see the BigFix Relevance Language Reference and the Inspector
Guides.

Organization of this Manual

This document addresses the reporting features and the configuration settings for the Web
Reports program. There are three major areas of discussion:

° Overview. This chapter provides details on pre-existing reports that convey a high-
level view of the health of the network.

° Creating, Managing, Scheduling, and Filtering Reports. These chapters show you
how to create, and manage your reports.

° Configuring Email, Databases, and User Privileges. These chapters show you how
to configure the overall Web Reports environment.

Versions

This document describes functionality available in BigFix Web Reports version 7.2.
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Requirements

Web Reports can run on a stand-alone server or on the same machine that hosts the BigFix
database. The requirements for the Web Reports server vary depending on the number of
databases, computers, actions, and retrieved properties you wish to track.

The Web Reports primary resource requirements revolve around memory size for fast access
and CPU speed for fast report processing. The disk stores a local cache to make load times
faster, but the disk speeds have less impact on the Web Reports than memory size and CPU
speeds.

BigFix deployments with more than 30,000 agents can benefit by having a separate Web Reports
server so that the main BigFix Server does not need to share its resources. You can set up
multiple Web Reports servers with minimal performance impact on the main BigFix Server.

Web Reports Server requirements:

Number of BigFix Agents CPU Memory
< 10,000 2ghz 1GB
10,001-30,000 2ghz (dual core) 2GB
30,000-100,000 2ghz (dual core) 3GB
100,000-200,000 2ghz (quad core) 4 GB

The client browser requires Internet Explorer v. 6.0 or Mozilla Firefox. In order to view the graphs,
you also need Adobe Flash Player version 9 or higher.
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Part Two

The Big Picture

Viewing Web Reports

BigFix Web Reports is divided into several sections, with two main methods of navigation, the
side bar and the top bar.

Side Bar Navigation

The left navigation bar provides links for quick access to reports you designate as Favorites and
visited pages.

Favorites *

» Dperating System
Distribution

» Progress of 10 Fixlets
Recently Relevant

» Action List

Recent History #

= Overview

» Progress of 10 Fixlets
Recently Relevant

» Report Management
» Vulnerabilities by OS5
« All Fixlets

» Report Management
s Dverview

[Clear History]

Top Bar Navigation

The top navigation provides links to view the Overview, Reports, Create, Schedule, Email,
Users, or Database page:

o) BES WEB REPORTS

Overview | Bl Reports | Ef Create | @ Schedule | B3 Email | 22 Users | @ Database
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(] The Overview section contains graphs and statistics that convey a general, high-level
sense of the health of the network.

(] The Reports section offers shortcuts to previously generated reports and links to
external reports outside of the Web Reports application. It also allows you to select
useful reports to be placed in the “Favorites” section for quick access.

° The Create section allows you to create basic reports that are capable of analyzing
specific parts of the network based on certain criteria. These reports can be stored for
viewing at a later date, viewed in a printer-friendly format, or saved in a format that
can be imported into Excel or an equivalent spreadsheet application.

° The Schedule section allows you to run reports at a given time or when certain
conditions are met. The report results can then be emailed to you or archived for later
viewing.

° The Email section configures the email server settings, and allows you to edit your
email addresses.

° The Users section handles Web Reports user management: adding, deleting, and
editing users.

° The Database section takes care of BigFix database management. This includes
adding, deleting, and editing database connections and settings.

The following chapter will discuss each of these sections in greater detail.
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The Report Pages

Overview Page

The BigFix Web Reports Overview page contains graphs and tables that visually represent the
overall state of your network, as well as the effectiveness of your BigFix deployment. Next to the
tittes of each, there is a bracketed question mark [?], which you can click for additional
information.

Note:  Reports will be disabled if a user is logged in without sufficient privileges to view
them, or if the report is filtered. Users are not considered to have sufficient
privileges unless they have full rights to all the computers on the server.

The following sections describe each of the graphs, charts, and tables presented in the Overview.

Total Issues

The Total Issues graph adds the number of relevant Fixlets for each computer and then groups
the issues by their severity rating. An issue is a Fixlet message that is relevant on any computer
in your network. For example, if you have a computer with 5 relevant Fixlet messages and a
second computer with 3 relevant Fixlet messages, the total number of issues is 8, even if some of
those messages are the same.

This graph can be set to different time granularities by selecting from the pull-down menu above
the graph. The Auto-Fit Data option will automatically group the data in the graph for up to the
last twelve months of your BigFix installation. Last 7 Days will group the data by day and show
the last seven days. Last 30 Days will group the data by day and show the last thirty days. Last
26 Weeks will group the data by week and show the last six months. Last 52 Weeks will also
group the data by week and show the last year.

Total Issues [Exportto CSV]

Auto-Fit Data -

50000
40000
30000

20000
Critical
6/19/07
170 (B.2%)
total: 2069

A — _fa

10000

o (R ——

Hover your cursor over any point in
4/3/07 4/15/07 5/5/07 5/21/07 6/6/07 6/22/07 7/8/07 the graph to see a pop-up Containing

B unclassified Low Moderate Important [J] Critical more detail.

Different colored bars represent different issue severity. The height of each bar represents the
number of issues for a particular bar. For example, if a bar for important issues starts at 300 and
ends at 500, the total number of important issues is 200.
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Total Number of Computers

The Total Number Of Computers graph displays the number of computers that have been

under BigFix management in a given period of time. This graph offers a way to monitor additional
deployments of the BigFix Client over time.

Total Number of Computers (- ; [Exportto CSV]

[ Auto-Fit Data !

50

40

30

20

1o

o
4207 417,07 5,207 5/17/07 64107 &/16/07 FLL/0TF 716,07

B computer Count

Like the Total Issues graph, this graph will be disabled if a user logs in without sufficient
privileges. Select the desired time scale from the pop-up menu above the chart. Move your cursor
over specific data points for more information.
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Computer Vulnerability Status

The Computer Vulnerability Status pie chart groups computers according to their most severe
vulnerability.

Computer Vulnerability Status | -, [Exportto CSV]

36 Computers Total

If a computer has a Critical vulnerability, it will be considered to have critical status, regardless of
other vulnerabilities it might possess. If a computer has no critical vulnerabilities, but has an
Important vulnerability, it will be considered to have important status, etc., providing a general
sense of how your network is doing. Initially, the vulnerability pie will be mostly red (critical), and
as you continue to use BigFix, it will become green (no vulnerabilities). Hover your cursor over
each pie slice to see the actual number of computers with each vulnerability state, and the
percentage of network computers they represent.
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Issues Remediated

The Issues Remediated graph counts the number of computers that have returned Fixed in
response to an action. The time segment for an action is pegged to its start time, not its
completion time (which may occur in a subsequent time segment). This graph gives you a good
picture of remediation rollouts across your enterprise as BigFix finds and fixes vulnerabilities.

Issues Remediated

| Auto-Fit Data

v

16

14

12

10

Ia

X

P unclassified

U|III‘I || III||H

4,207 41707 5/2/07 5417707 &/1/07 &/1e/0F Fr1/07 716407

Low

[Export to C3W]

Important ] Critical

This is a historical graph. Select a time scale from the pop-up menu above the chart. This graph
displays colored bars representing the severity of remediated issues, and lets you highlight data

with your cursor.
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Overall Statistics

The Overall statistics table displays important facts about your network:

Overall Statistics

Total Number Of Computers: 36 Relevant Fixlets Per Computer (average): 88.50

Total Number Of Fixlets: 11375 Total Mumber Of Fixlet Sites: 35

Total Number Of Tasks: 364 Total Number Of Analyses: 180

Total Number Of Actions: 1349 Mean Time To Remediate: 10 days, 20 hours, 38 minutes, 30 seconds

° Total Number of Computers: the current number of BigFix Clients.

° Relevant Fixlets per Computer: the average number of relevant Fixlets per computer,
or the total number of relevant issues divided by the total number of computers.

° Total Number of Fixlets: the current number of Fixlets that exist on the BigFix system.
Note that if Web Reports is looking across multiple databases in the network, the
number of Fixlets will be the union of all the Fixlets in all the databases.

° Total Number of Fixlet Sites: the total number of sites to which the BigFix system is
currently subscribed.

° Total Number of Tasks: the current total of relevant tasks on your BigFix network.

° Total Number of Analyses: the current total of Analyses that exist on the BigFix
system.

(] Total Number of Actions: the current total of actions issued so far by the BigFix
system.

(] Mean Time to Remediate: the average time it took for every relevant issue to become
non-relevant on all computers. Note that issues may become non-relevant by methods
other than actions. For example, users can manually update their computers, making
those relevant issues no longer relevant.
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Top 10 Critical/Important Issues Detected

The Top 10 Critical/lmportant Issues Detected report displays Fixlet messages that are

currently affecting the largest number of computers on the network.

Top 10 Critical | Important Isswes Detected

NSI’I’Ig
1. Wersion of Dbemslpenodil May Cause Handle Leak on BES Client'Senver Companenls
2. Updated BES Clignl Now Availablel [Version 7.0,1,356] - WinK T2 000Z2003%P
3 M50T-012: Vulnerability in Microsoft MFC Could Allow Remote Code Exscution - Windows XPEO03 (xi4) (v2, re-relagsed
tEMZRDIT)

4, MS06-07E: Vulnarability in Windows Media Forma Could Allew Remale Code Exscution - Windows Media Player 6.4
{re-released TI02007)

5. MSOT-031: Vulnerabillty in the Windaws Schanned Sacurity Fackage Could Allow Remots Code Execution - Windows XF SF2

B, MISOT-035: Vulnarability in Win 32 AF1 Could Allow Remole Code Exedution - Windows XP 5P2

T. MS0T-034: Cumitative Security Uipdale foe Outicok Express and Windaws Mail - Windows XF 5F2

B, MS060688; Valnerability in Microsoft Agent Could Allow Remale Gode Execulion - Windows XP 5P2

8. MS0T-002: Valnarability in HTML Halp ActiveX Control Could Ao Remeis Code Exacufion - Windows XF 5F2

10. MS0T-009: Vulnerability in Microsoflt Data Access Components Could Alow Remos Code Execution - ‘Windows XF 3P2

SOUMe
Seyerty
Impartant
Imparant

Impartant
Crilical
Critical
Critical
Imparant
Crilical
Critical
Crilical

Alecied Faich
Camputers Completon
10 0.00%
52.94%
] 0.00%
5 0.00%
5 0.00%
3 0.00%
5 0.00%
4 0.00%
4 uKilel
4 0.00%
Show Progress ol Teg 10 Crilical | impartant Issues

There are four columns in this list:

° The Name column lists the name of the Fixlet message.

° The Source Severity column lists the severity of each common Fixlet.

° The Affected Computers column displays the number of computers that currently
have the Fixlet relevant. The Fixlet list is sorted by the Affected Computers count.

° The Patch Completion column is the percentage of fixed computers out of the total
number of computers that have ever been affected by the listed Fixlet.

Beneath the list of the top 10 most common issues, the Show Progress of Top 10

Critical/mportant Issues link brings up a progress report.

Progress of Top 10 Critical / Important Issues
Last refreshed: Fri, Jul 20, 2007 al 2228 PM

0.00%

MS07-035: Vulnerabality in Win 32 AP Could Allow Remala Code Exacubon - Wingows XP SP2
5 Computers Total. 0.00%

First detected: Tue, Jun 12, 2007 a16:53 PM

Mean Gme 1o remediale: Unknown

0.00%

Updated BES Clienl Now Available! (Version 7.0.1.356) - WinNT.200020037XP
17 Compuiers Total. 52.84%

First detectad: Thu, May 10, 2007 a1 10:35 PM
Mean ime 1o remediate: 2 days, 9 howrs, 3 minules, 33 seconds
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For each issue, the following information is displayed:

° The name of the Fixlet message.

(] The number of computers affected by this issue.

(] The percentage of computers where BigFix has deployed the action.

° The time and date when BigFix first detected the issue.

° The mean time BigFix has taken to remediate this issue across your network.

° A progress bar beneath each issue indicating the percentage of computers that have
been remediated out of the total number affected.Managing Reports

Click the Reports link to bring up the Report Management page. It has three main sections:
Content Reports, Public Reports, and My Reports.

You can sort tables and lists contained in the Reports page by clicking on their column headings.
Clicking on the same column again will switch the order of the sort.

You can designate Favorite reports that get listed in the Favorites box in the left navigation
panel. Click the [add] or [remove] link in the Favorite column to switch the label between Yes
(Favorite) and No.

You can include links to External reports on this page. Click the Add External Link button, fill out
the Report Name and Description, and add the full URL of the external report. The URL must
start with http:// or https://.

You can also import local reports. Click the Import button and specify a report file. Importing a
report brings in the actual report rather than a link to a file.

Report Management

Caornent Reparts
(7 regans found, Displaying repoits 1-7)

Ty Eherain - a0ty Source Favarily

BESTOBet  Enberpise Seculity Repon Vunasability Hotspot Rispan - Source Nojaad]
BEST7.0Bea Enterpnise Secunty Repor MSPICRALBONSIANS - SOUFCE Nofadd Py
BES 7.0 Bela Enterpnse Secuty Repart maEpatches - Source Nojada] copy
BESTest Custom Report mapatches - Source Nofadd]

BESTest Cusiom Reparn mapaiches - Source Nojasdd]

BESTost Entemprias Socufty Ropor MSRALRACIONSIIS - Source Nojadd
BESTOBem  CEnerpeise Sscurity Repon Vunerability Hotspot Repon - Source Nojadd]

Public Reports
(14 repoets found. Dvsplaying reports 1-14)

fion List Action Summary Admin

-
r Unknown pal

r Unkrsown Pl

r All Analysos Admn

r Compulor Properioes Admin

r Relevant Fixets Admin

L Single Revevea Propemy Stans Admin

T Al Operators Admin

T Computar Propames Admin

T Fiadel Progeess Admin

L evant Filet Progress Admin

r Compuier Properies Admin

I Compuier Properes Admin

r Relevant ssue History Admin Noladd rename
My Roports

[ repans found, Displaping repons 1-3)

Favone
Singhe Retnevia Propery Stans Nojasd
Singlo Retieved Property Status Nojadd
r RelevanceTest Test MNojacd] udil

Delete Reports

Import Report | Add External Link
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Content Reports

Content Reports are created by BigFix Sites and automatically distributed to Web Reports. There
are five columns describing reports in this list:

° The Name of the stored report.

(] The Sitename for the report.

(] The Category of the stored report, such as Enterprise Security, or Custom.

° The Source of the stored report, such as Vulnerability Hotspot or Action Status.
° The Favorite column lets you add or remove a report from your Favorites list.

° The Copy column allows you to copy the report, in case you want to make minor
changes. Copying brings the copied report into My Reports or Public Reports,
depending on the visibility you select.

Public Reports

Public Reports are created by any Web Reports user and saved as Public. Web Reports only
saves the templates; it generates the underlying data at report time.

At installation, several reports are included in this section. The included reports are:

° Action List

° Analysis List

° Computer Properties List

° Open Vulnerabilities List

° Operating System Distribution

° Operator List

° OS Vulnerability Summary

(] Progress of 10 Fixlets From Recent Actions
° Progress of 10 Fixlets Recently Relevant
° Vulnerabilities by Console Operators

] Vulnerabilities by OS

L] Vulnerability Trends Over Time
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There are six columns describing reports in this list:

° The first column consists of check boxes. If you want to delete a report, click the
appropriate check box, then click Delete Reports.

° The Name of the stored report.

o The Category of the stored report, such as Action Summary, Fixlet Progress, or
Computer Properties.

(] The Creator column lists the name of the BigFix Operator who created this report.
° The Favorite column lets you add or remove a Report from your Favorites list.

° The last columns allow you to rename a stored report, if you are the report’s creator or
a Web Reports administrator. Clicking rename brings up a new page allowing you to
change the name, description and category of the report. If you have custom reports
in this section, you can edit them if you are the creator or a Web Reports
administrator. Clicking edit brings up the report’s Create page, so that you can edit its
contents.

My Reports

The My Reports section of this page includes all reports you have created and saved, including
test and sample reports. This section includes:

(] The first column consists of check boxes. If you want to delete a report, click the
appropriate check box, then click Delete Reports.

(] The Name of the stored report.
° The Category of the stored report, such as Single Retrieved Property Status or Test.
° The Favorite column lets you add or remove a Report from your Favorites list.

° The fifth columns allow you to rename or edit a stored report. Clicking rename brings
up a new page allowing you to change the name, description and category of the
report. Clicking edit brings up the report’s Create page, so that you can edit its
contents.
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Creating Reports

You can create and customize report templates and use them to generate reports at any time.
Click the Create tab to display the Create Report page.

Create Report

Please choose a repaort type:

Computer:
" Computer Properties
€7 All Computers

Retrieved Property:
" Single Retrieved Property Status

Analysis:
€ mil Analyses

Fixlet:

" All Fixlets

* Relevant Fixlets
" |ssue Assessment
" Issue Compliance
" Fixlet Progress

Task:
¢ All Tasks

Baseline:
7 All Baselines

Action:
" Action Summary

History:

" Fixlet History

" Relevant Issue History

" Average Relevant Issue History

Unmanaged Assets:
" All Unmanaged Assets

Operators:
Al Operators

Hidden:
" Hidden ltems

Advanced:
" Blank Report

Next |

Relevant Fixlets
Find Flakis St Slot with Eaarch

[0 Fidota kound Dxsplmeng Fosers 1100

e Qi uaias Fialsl Al

ure Vunerbities o
Windzes. Sy stame

Pariches for Selane

Lists all relevant Fixlets and analogous information to the "All Fixlets' report.

10 ME imposant
. 00§ cUniproted>

11 kB cimaprcieds

“no
dowringds H
o
fominarts
o
dowrioads E
o
dowrias
<no
doninags .
o

dosrivads E'
no
duwrinart
<o
dmwmicads
g
o=
o
frowi s
o
il s

HE
dowmi et
e

doswrl pad
o

dowriads
ITBEME . e

Low

17 W KA
120 WG =hiAn

Simply click any of the buttons and then click Next to supply the details of your report. The next
chapter provides details on each of these built-in report formats.
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Part Three

Reports

There are hundreds of ways you can view your data in report format. Some of them entail only a
few keystrokes, and others require you to customize them to suit. This chapter discusses them all
in detail.

Frequently Used Reports

This set of reports is used for asset management, auditing and inventory, as well as monitoring
the effectiveness and efficiency of your BigFix system. On the right-hand side of the page, there
is a visual representation of the currently selected report. Click the buttons to get a quick
overview of available reports.

You can filter reports by computer properties and narrow them down by database, site, or
computer. Reports can be viewed in printable format or exported as CSV (comma-separated
values) to be viewed in a spreadsheet.

This page organizes the reports into several categories: Computer, Retrieved Property, Analysis,
Fixlet, Task, Baseline, Action, History, Unmanaged Assets, Operator, Hidden and Advanced.
Each category has a set of predefined report types. To select a specific report, click the
appropriate button, then click Next. A subsequent page will prompt you for any extra information
needed for your report. The following sections discuss each report type and the parameters you
need to specify.
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Computer Properties Report

This report is one of the most powerful, useful, and resource-intensive BigFix reports available.
You can group computers in the network by retrieved properties while summarizing other

properties of individual computers.

Relay =

w2kserver:52311

turkey:52311

QABES:52311

gabes.bigfix.com:52311

Computer Properties

BES Client Version

7.0.1.354

7.0.1.354

6.0.16.46

6.0.9.54

6.0.16.41

6.0.16.46

701327

7.0.1.354

Computer Name =

(2 computers found. Displaying computers 71-2)
QAVISTAT
WINZK-PRO-GOLD

(3 computers found. Displaying computers 71-3)
BRAWINZKOA

Default

TURTLEDOWE

(1 computer found. Displaying computer 1-1)
hp1123

(2 computers found. Displaying computers 7-2)
Ryan Russell's iBook G4
WHKMac

(1 computer found. Displaying computer 1-1)
lacalhostlocaldomain

(3 computers found. Displaying computers 1-3)
einstein

socrates

win2k-pro-spd

(1 computer found. Displaying computer 1-1)
QAWINZK3IXE4

(5 computers found. Displaying computers 7-5)
BASE10A

NT_SERVER

QAWINZ003XE4

W2ZKSERVER

XPQA

To create the Computer Properties report:

1. Select Create > Computer Properties. Click Next.

2. To sort and group the data by specific properties, select from the lists in the Primary,
Secondary, and Tertiary boxes. If you select no parameters, the report will list all computers
in the network.

a. If you are aggregating over multiple databases, select the Group by database box.

b. If you wish to group computers based on their Computer Group, check the Group by

computer groups box.

3. Select the main property or properties of interest for this report from the Summarize box. The
values you select will be displayed next to the computer name in the listing.
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4. Check the Include relevant Fixlets box to display the list of relevant Fixlets for each
computer. This gathers a large amount of data, and can be a very slow report to process. If
this box is checked when the Hide individual computers box is checked, the Fixlets will also
be hidden, and only the number of relevant issues for a computer will be displayed.

5. Check the Include remediated Fixlets box to include remediated Fixlets and are no longer
reporting relevance for this issue.

6. Check the Hide individual computers box if you want to suppress the individual computer
names in the report. If this box is checked, just the number of computers in each retrieved
property group will be listed and the Summarize properties will be ignored.

7. Check the Hide individual Fixlets box if you want to see just the number of Fixlets, not each
one.

8. Check the Hide undefined results box if you want eliminate certain results from the report,
such as error, none, not reporting, undefined, unknown or n/a.

9. Click Next to generate the report. The report is displayed in a new page.

10. Click the column headers to sort the items.

Use the Current Report box in the left panel to Filter, Configure, Store, Export, Print, or Email
this report.
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All Computers Report

This report lists all the computers on your network, along with their computer ID, Database and
Last Report Time. You can also search for computers. The search results display as a list.

All Computers
Find computers that stanwithtl Search |
{38 computers found. Displaying computers 1-38)
Computer Name & Computer 1D Database Last Report Time
ALTAVISTA 7495509 QABES 2007-07-20 18:12:12
BASETQA 1005057 QABES 2007-07-20 18.07.57
BRAWINZKOA 12267196 QABES 2007-07-20 17:59:44
CONVERTER 87460912 QABES 2007-07-20 18:09:33
Default 1417143 QABES 2007-07-20 17:53:.41
ginstein 11979871 QABES 2007-07-20 14:51:20
hp1123 B3B4743 QABES 2007-07-20 18:13.03
Intel Mac Mini's Computer 1175551937 CQABES 2007-07-08 12:22.48
KILLDEER 8077132 QABES 2007-07-20 18.09:49
KODKABURRA 1175551982 QABES 2007-07-20 18:08:47
LAUGHINGTHRUSH 29784487 QABES 2007-07-20 18:01:26
linux 15875327 QABES 2007-06-26 11:04:31
localhostlocaldomain 602281 QABES 2007-07-20 18:04:53
localhostlocaldomain 15842535 QABES 2007-07-20 17:35:56
NT_SERVER 2878530 QABES 2007-07-20 18.06:56
other 21357268 QABES 2007-07-18 13.57:33
PTARMIGAN 14464096 QABES 2007-07-20 18:04:05
QABES 4301372 QABES 2007-07-20 18.09:40
QABIG 850202349 QABES 2007-07-20 18:06:45
QAUKEMACHINES 2358357 uk 2007-07-20 11:50:20
QAVISTAT 12268237 QABES 2007-07-13 13:44:05
QAVISTAZZ 3572063 QABES 2007-07-20 18:06:51
QAWINZ2003X64 2956105 QABES 2007-07-16 11:21:23
CAWINZ2003XE4 4490097 QABES 2007-07-20 18:12:48
QAWINZK3X64 1600133 QABES 2007-06-28 11:57:50
ROEBIN 16306243 QABES 2007-07-20 16:.40:48

To view the All Computers report:

1. Select Create > All Computers, and click Next. The report lists all the computers managed
by BigFix, along with their name, ID, database, and last report time.

2. Click on the name or ID of any computer to view the Single Computer Report.

Use the Current Report box in the left panel to Filter, Configure, Store, Export, Print, or Email
this report.
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Retrieved Property Report

This report analyzes the value of a single computer attribute (retrieved property) across the
BigFix network. The report displays as a table, illustrated by your choice of a pie or bar chart.
Click on column headers to sort the list. Click on an entry in the Computer Name or Computer
ID column to view a detailed report on that computer.

Retrieved Property "OS"

.WinXF'-EDDS 5.2.3790
B WinxP 5.1.2600
8 Win2000 5.0.2195
Win2003 5.2.3790
@ macosx 1049
 WinVista 6.0 5744
@‘.ﬂfin\r‘ista §.0.6000
B winNT 4.0.1381
B HP-UX B.11.23 (U)
Linux Red Hat Enterprise ES 3 (2.4.21-20.EL}
[l 5un0S 5.8 (Generic_108528-14)
Linux Red Hat Enterprise ES 3 {24,214 EL)
Win95 Initial 67100814
B Linux Red Hat 4.1.1-52 {2 6.18-8 &l5)
& Linux Fedora Core 3 (2.6.11-1.27_FC3smp)

Other

0s Count Percent w
(17 results found. 38 computers counted. Displaying top 15 results.)

WinXP-2003 5.2.3790 6 15.79%
WinXP 5.1.2600 6 15.79%
Win2000 5.0.2185 5 13.16%
Win2003 5.2.3790 4 10.53%
Mac OS X 10.4.9 3 7.89%
WinVista 6.0.5744 2 5.26%
WinVista 6.0.6000 2 5.26%
WinNT 4.0.1381 1 263%
HP-UX B.11.23 (U) 1 2.63%

Linux Red Hat Enterprise ES 3 (2.4.21-20.EL) i 263%

SunOS 5.8 (Generic_108528-14} 1 2.63%
Linux Red Hat Enterprise ES 3 {2.4.21-4 EL) 1 2.63%
Wing5 Initial 67109814 1 2.63%
Linux Red Hat 4.1.1-52 (2.6.18-8.e15) 1 2.63%
Linux Fedora Core 3 (26.11-1.27 FC3smp) 1 263%
{17 results found. Displaying results 16-17)

Linux (2.4.19-64GB-SMP) 1 2.63%
Mac OS X 10.4.5 1 2.63%

To generate this report:

Select Create > Single Retrieved Property Status. Click Next.
From the scrolling list, select the name of the retrieved property you wish to summarize.

Select a graph type (pie, bar or no graph) to be included in the report. For a pie chart or a bar
graph, you will be able to customize the color set.

4. Select the number of unique values you wish to label with a specified color.
If you choose, customize the first 16 colors you wish to apply to the retrieved property values.
Click Next to generate the report.
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Your report appears, listing the unique values of the retrieved property and the number of
computers reporting each value. If your report contains a graph, only the first 15 values in the list
are graphed independently; the rest of the results are combined into a 16th value. The default
sort is by descending count or percent, forcing the first 15 values to be the biggest and
presumably most important. You can click on a column heading to sort the table.
Use the Current Report box in the left panel to Filter, Configure, Store, Export, Print, or Email
this report.
Note:  Since a computer can have multiple values for a single retrieved property, the
total number of results listed can be larger than the number of computers on the
network.

You can also run this report by clicking on the link for a retrieved property in any other report.

Use the Current Report box in the left panel to Filter, Configure, Store, Export, Print, or Email
this report.

All Analyses Report

This report lists all the Analyses that are available to your BigFix system. You can sort the list by
Name, Sitename, Database, Activated By, Time Activated, and Status.

All Analyses
Find Analyses that start with: Searcll_l
(180 analyses found. Displaying analyses 1-700)
Name « Sitename Database Activated By  Time Activated Status
3 i v i 2007-04-26 Activated
Adobe Product Detection (Windows) BES Inventory and License QABES bigfix 14:22:24 Globally
. N i ; 7 2007-07-18 Activated
Adobe Product Detection (Windows) BES Inventory and License uk EvaluationUser g e Globally
AIX 5.2: Recommended Service Pack 5200-09-02 Patches for ALX QABES Not Activated
u o 2007-04-02 Activated
AIX Custom Fileset Deployment Results Patches for ALX QABES bigfix 17:05:59 Globally
= 2007-04-02 Activated
AlX Inventory: Compare_Report Resulis Patches for AlX QABES bigfix 17:05:59 Globally
a . 2007-04-02 Activated
AIX Inventory: Instfix Results Patches for AlX QABES bigfix 17:05:59 Globally
. X 2007-04-02 Activated
AlX Maintenance Level Package Deployment Results (Volume 1) Patches for AIX QABES bigfix 17:05:59 Globally
A ” i 5 2007-04-02 Activated
AlX Maintenance Level Package Deployment Results {Volume 2} Patches for ALX QABES bigfix 17:05:59 Globally
& " 2007-04-02 Activated
AlX Package Deployment Results - TL/SP/CSP Patches for AlX QABES bigfix 17:05:59 Globally
Application Information (ALX) BES Inventory and License uk Not Activated
e q .‘ : 2007-04-26 Activated
Application Information (ADX) BES Inventory and License QABES bigfix 14:22:24 Globally
Application Information (HP-UX) BES Inventory and License uk Not Activated
e : 5 i 2007-04-26 Activated
LX)

Application Information (HP-LEX) BES Inventory and License QABES bigfix 14:22:24 Globally
Application Information {Linux) BES Inventory and License uk Not Activated
s % s . 2007-04-26 Activated

Application Information (Linux) BES Inventory and License QABES bigfix 14:22:24 Globally
Application Infarmation (Mac OS X) BES Inventory and License uk Not Activated
] 4 Y + 2007-04-26 Activated

Application Informafion (Mac OS X) BES Inventory and License QABES bigfix 14:22:24 Globally
Application Infarmation (Solaris) BES Inventary and License uk Not Activated
it : i ; 2007-04-26 Activated
Application Information (Solaris) BES Inventory and License QABES bigfix 14:22:24 Globally
S— s = : 2007-04-28 Activated
Application Information (Windaws) BES Inventory and License QABES bigfix 14:29:24 Globally
At - 2007-04-02 Activated
Wi ¥
Application Information (Windows) BES Support QABES bigfix 17:05:59 Globally

To create the All Analyses report:

1. Select Create > All Analyses. Click Next. A report is generated, listing all analyses.
2. Click on any individual link in the Name to bring up an in-depth report on that analysis.

3. Click on any link in the Activated By column to see all analyses activated by that user.

Use the Current Report box in the left panel to Filter, Store, Export, Print, or Email this report.
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All Fixlets Report

This report lists all Fixlet messages that are available to the BigFix system. The report headers
include Name, Sitename, Fixlet ID, Affected Computers, Remediated Computers, Deployed

Actions, Download Size, and Source Severity.

All Fixlets

Find Fixlets that start with: |

Search

(17376 Fixlets found. Displaying Fixlets 1-700)

Name « Sitename
*Standby” Power Management Seftings Enabled on BES Power
Windows Server 2003 Management
"Turn off hard disk” Power Management Seftings Enabled  BES Power
on Windows Server 2003 Management

Ink File-Open Remate Code Execution Vulnerability (64-bit - Vulnerabilities to
XP SP1) Windows Systems

Ink File-Open Remate Code Execution Vulnerability (Server Vulnerabilities to

2003) Windows Systems
Ink File-Open Remate Code Execution Vulnerability (Server Vulnerabilities o
2003,5P1) Windows Systems

Vulnerabilities to
Windows Systems
Vulnerabilities to

Ink File-Open Remote Code Execution Vulnerability
(Windows 2000,5P4)

Ink File-Open Remote Code Execution Vulnerability

(XP,5P1) Windows Systems
JInk File-Open Remote Code Execution Vulnerability Vulnerabilities to
(XP SP2) Windows Systems

Vulnerabilities to
Windows Systems
Vulnerabilities to

Ink File-Properties Remote Code Execution Vulnerability
(Windows 2000)
Ink File-Properties Remote Code Execution Vulnerability

(Windows XP) Windows Systems
NET 2.0 Application Folder Information Disclosure Vulnerabilities to
Vulnerability Windows Systems

Vulnerabilities to

NET Framework 2.0 Cross-Site Seripting Vulnerability Windows Sysiems

Fixlet
D

5

]

70801

153701

156101

148801

132901

151701

118201

111801

41801

37701

Affected
Computers

Remediated
Computers

Deployed Download Source
Actions Size Severity

180 KB <Unspecified>
1B0 KE <Unspecified>
zgarn load> High
zzalnloa(b High
;:;nloaib High
;E;nluatb High
download>  High
downioag>  Mioh
downloag>  Medium
downloag>  Medium
;gs.rn load> M=dium
zgalnlaa(b Medium

To create the All Fixlets report:

1. Select Create > All Fixlets. Click Next. A report is generated, listing all Fixlet messages

across your BigFix database servers.

2. The column headers include those based on your default user settings. Sort the list by

clicking on any desired column heading.

Click on any individual Fixlet message to bring up an in-depth report.

Actions column to see a detailed report.

Click on any link in the Affected Computers, Remediated Computers, or Deployed

Use the Current Report box in the left panel to Filter, Store, Export, Print, or Email this report.
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Relevant Fixlets Report

This report is similar in form to the All Fixlets report, but it displays only those Fixlet messages
that are relevant on at least one BigFix-managed computer.

Relevant Fixlets

Find Fixlets that start with'l Search |

(800 Fixlets found. Displaying Fixlets 1-100)

Name & Sitename FixletID Affected Remediated Deployed Download Source
Computers Computers Actions Size Severity
811630: Update for HTML Help Control - Windows 2000 Enterprise Security 81163001 1 0 o 1.00 MB <Unspecified>

828026: Update for Windows Media Player Script Commands -

WInXP. Win2000, 2003 Server Enterprise Security 82802601 3 0 ] 277 MB <Unspecified>
B28026: Update for Windows Media Player Script Commands-  Patches for Windows :
WinXP, Win2000, 2003 Server (Brazilian Portuguese) (Brazilian Portuguese} 82802601 1 o 0 2.78MB <Unspecified>
gie’f‘}'::rl URL Script commands - WinXP, Win2000, Win2003 Enterprise Security 83235301 1 0 0 272 MBE <Unspecified>
914784: Update to Improve Kernel Patch Protection - Windows o 1

XP/2003 (x64) Enterprise Security 91478401 2 0 o T.35 MB <Unspecified>
927891 Fix for Windows Installer - Windows 2000 SP4 Enterprise Security 92789105 2 0 0 121 MB <Unspecified>
927891: Fix for Windows Installer - Windows 2000 SP4 (Brazilian Patches for Windows e

Porluguese) (Brazilian Portuguese) 92789105 1 0 o 1.22 MB <Unspecified>
927891: Fix for Windows Installer - Windows XP SP2 Enterprise Security 92789101 5 0 0 120 MB <Unspecified>
927891 Fix for Windows Installer - Windows XP/2003 (x64) Enterprise Security 92789107 5 0 ] 433 MB =<Unspecified>
931836: CORRUPT PATCH - Windows XP/2003 (x&4) Enterprise Security 93183606 2 1 o TZ20 KB <Unspecified>
931836: Feb. 2007 Time Zone Update - Windows XP SP1/SP2  Enterprise Security 93183601 3 0 o 500 KB <Unspecified>
931836: Feb. 2007 Time Zone Update - Windows XP/2003 (x64) Enterprise Security 93183605 4 1 0 720 KB <Unspecified>
935448: Certain third-party applications may not start, and you

receive an error message when you start the computer: "lllegal Enterprise Security 93544801 2 0 i} T02 KB <Unspecified>
System DLL Relocation.” - Windows XP §P2

935843: Stop 0xD000D0OTF error when you print from computers : = :

with GDI security updale 925802 inslalied - Windows XP 5Pz CMefprise Security 93584301 2 i . 1.a6MA stinsprolied?

To create the Relevant Fixlets report:

1. Select Create > Relevant Fixlets. Click Next. A report is generated, listing all relevant Fixlet
messages across your BigFix installation.

2. Sort the list by clicking on any desired column heading.
The column headers are based on your default user settings.

4. Click on any individual Fixlet message to bring up an in-depth report.

Use the Current Report box in the left panel to Filter, Store, Export, Print, or Email this report.
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Issue Assessment Report

This report displays the affected and remediated computer counts for a selected Fixlet or group
of Fixlets. You can group the report by properties, database or computer groups. For each Fixlet,
there is a list of computers with columns including Subnet Address, Affected Count,
Remediated Count, Total Count, and Percent.

Issue Assessment

Fixlet Name Subnet Address Database Affected Count Remediated Count Total Count Percent
B11630: Update for HTML Help Control - Windows 2000
(7 result found. )

192.168.104.0

QABES 1 0 1 0%

828026: Update for Windows Media Player Script Commands - WinXP, Win2000, 2003 Server
(1 result found. )

192.168.104.0

QABES 3 o 3 0%
914784: Update to Improve Kernel Patch Protection - Windows XP/2003 (x64)
(7 result found. )
192.168.104.0
QABES 2 0 2 0%
8931836: Feb. 2007 Time Zone Update - Windows XP SP1/5P2
(2 results found. )
192.168.104.0
QABES 2 0 2 0%
uk i ] 1 0%
931836: Feb, 2007 Time Zone Update - Windows XP/2003 (x84}
(2 results found. )
192.166.101.0
QABES 1 0 1 0%
192.168.104.0
OABES 3 1 4 25%

To create the Issue Assessment report:

1. Select Create > Issue Assessment. Click Next.
2. From the displayed page:

a. Select primary, secondary, and tertiary retrieved properties to help you group the
issues in the list.

b. Check the appropriate box if you want to Group by database.
Check the appropriate box if you want to Group by computer groups.

d. Check the Show all subtotal and total counts box to show totals for different
groups of computers. If computers are not grouped by any properties, this step will
have no effect.

e. Select the desired Fixlet sites you wish to include in the report. If you don't select
any particular site(s), the report will include all of them.

f. Select the desired Fixlet message(s) from the list. Use Ctrl- and Shift-click to select
a group of Fixlet messages.

g. Click Next to generate the report. The report will generate, listing each Fixlet
message sorted by Fixlet Name. The report displays the number of computers
affected and remediated by each Fixlet.

3. Click on any Fixlet message for an in-depth report.

Use the Current Report box in the left panel to Filter, Configure, Store, Export, Print, or Email
this report.
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Issue Compliance Report

This report groups Fixlets and their targeted computers over selected time periods, allowing you
to examine Fixlet histories by age ranges.

Issue Compliance

Fixlet Name = Sitename Fixlet ID Release Date Computers Patch Deployment
Computer Name D Database

(18 issues found. Displaying issues T-718)

Restart Meeded - Not Triggered by a BES Action  BES Support 391 13 46.15%
Eemediated
(6 computers found. )
LAUGHINGTHRUSH 29784487 QABES
QABIG 85020239 QABES
ROBIN 16306243 QABES
TURKEY 5651953 QABES
TURTLEDOVE 1175551878 QABES
WIN2K-PRO-GOLD 1175551693 QABES

Less than 7 days relevant
(5 computers found. )

KOOKABURRA 1175551882 QABES
PTARMIGAN 14464096 QABES
QABES 4301372 QABES
QAUKEMACHINES 2358357 uk

QAWINZ003XE4 4480087 QABES

7-30 days relevant
(2 computers found. )

ALTAVISTA 7485509 QABES
CQAWINZDD3XE4 2956105 QABES
Restart Needed - Triggered by a BES Action BES Support 390 5 100.00%

Eemediated

(5 computers found. )

KOOKABURRA 1175551982 QABES
LAUGHINGTHRUSH 29784487 QABES

NT_SERVER 2878530 QABES

TURKEY 5651953 QABES
WIN2K-PRO-GOLD 1175551693 QABES

To create the Issue Compliance report:

1. Select Create > Issue Compliance. Click Next.
2. From the displayed page:

a. Select the desired Fixlet sites you wish to include in the report. If you don't select
any particular site(s), the report will include all of them.

b. Select the desired Fixlet message(s) from the list. Use Ctrl-Click or Shift-Click to
select a group of Fixlet messages.

For grouping the Fixlets, select the Primary and Secondary time periods, in days.

4. Typical values are 7 and 30, providing three natural periods: within a week, between a week
and a month, and greater than a month.

5. Check the box to Hide individual computers to produce a summary.
6. Click Next to generate the report.

The report is generated, listing each Fixlet message, sorted by Fixlet Name.

Click on any computer or Fixlet for an in-depth report.
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For each Fixlet, there are the following categories:

° Remediated computers. This is the list of computers for which the Fixlet is no longer
relevant.

° Less than the Primary period. This is the list of computers that have most recently
been targeted by this Fixlet.

° Between the Primary and Secondary period. This is the list of computers that
became targeted during middle range of Fixlet aging.

(] Older than the Secondary period. This is the list of laggard computers, where a
Fixlet has been relevant for a long time, but still not remediated.

(] Indeterminate period. Occasionally a Fixlet will have an unknown history, and this is
the list of those computers.

Use the Current Report box in the left panel to Filter, Configure, Store, Export, Print, or Email
this report.

Fixlet Progress Report

This report displays the remediation progress of a specified Fixlet or group of Fixlets. For each
Fixlet, it displays the number of computers affected, the detection date, the mean time for
remediation and the percentage of computers that have been successfully remediated.

Fixlet Progress

Last refreshed: Tue, Jul 24, 2007 at 11:49 AM

Cutdated Internet Explarer - BES Console

0 Computers Total. 0.00%
First detected: Unknown
Mean time to remediate: Unknown

0.00%

Festart Needed - Not Triggered by a BES Action

13 Computers Total, 46.15%
First detected: Mon, Apr 9, 2007 at4:52 PM
Mean time to remediate: 6 days, 1 hour, 48 minutes, 20 seconds

Restart Needed - Triggered by a BES Action

5 Computers Total. 100.00%
First detected: Wed, Apr 25, 2007 at 7:06 PM
Mean time to remediate: & days, 4 hours, 47 minutes, 58 seconds
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To create the Fixlet Progress report:

1. Select Create > Fixlet Progress. Click Next.
2. From the displayed page:

a. Select the desired Fixlet sites you wish to include in the report. If you don't select
any particular site(s), the report will include all of them.

b. Select the desired Fixlet message(s) from the list. Use Ctrl- and Shift-click to select
a group of Fixlet messages.

c. As well as manually selecting Fixlet messages from the list, you can automatically
select a batch of Fixlets that have been acted upon. Enter the size of the batch and
click the first Select button. The Fixlets in this range will be listed in the gray box to
the right.

d. You may also select a batch of Fixlets that have become relevant. Enter the size of
the batch and click the second Select button. The Fixlets in this range will be listed in
the gray box to the right.

e. The gray text box to the right contains a list of your current selections and reminds
you if nothing has been selected.

3. Click Next to generate the report.

The report generates, listing the designated Fixlet messages. At the top of the report is the last
refresh date.

For each Fixlet, there are these lines of information:
(] The name of the Fixlet message.

(] The total number of computers targeted by this Fixlet message and the percentage
of them that have been remediated.

° The date that the Fixlet was first detected.
° The mean time for remediation.

° A progress bar that turns green as more computers are remediated.

Click on any Fixlet link for an in-depth report. Use the Current Report box in the left panel to
Filter, Configure, Store, Export, Print, or Email this report.
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All Tasks Report

This report lists all Tasks available to your BigFix system. For each Task, the report has a column
for the Name, Sitename, Task ID, Affected Computers, Remediated Computers, and
Deployed Actions.

All Tasks
Find Tasks that start with: Search
(363 Tasks found. Displaying Tasks 7-100)
Name & Sitename Task ID Affected Remediated Deployed
Computers Computers Actions
Action Language - Continue If ActionSite (QABES) 16383 37 o 0
Action Language - Continue If ActionSite (QABES}) 21184 ar 0 0
Action Language - Copy and Appendfile ActionSite (QABES}) 16384 37 o 0
Action Language - Copy and Appendfile ActionSite (QABES) 21185 37 ] 0
Aclion Language - Delete ActionSite (QABES) 18385 ar 1] 0
Action Language - Delete ActionSite (QABES} 21186 37 o 0
Action Language - Download ActionSite (QABES) 18389 37 0 0
Action Language - Download ActionSite (QABES} 21190 v 1] 0
Action Language - Download As ActionSite (QABES) 18386 a7 o 0
Action Language - Download As ActionSite (QABES) 21187 ar o 0
Action Language - Download Now ActionSite (QABES} 18388 37 ") 0

To create the All Tasks report:

1. Select Create > All Tasks. Click Next. A report is automatically generated, listing all the
Tasks across all the BigFix database servers.

2. Click on any individual Task to bring up an in-depth report.

3. Click on a number in the Affected Computers or the Remediated Computers column to
see a detailed report on the data.

Use the Current Report box in the left panel to Filter, Store, Export, Print, or Email this report.

All Baselines Report

This report lists all the Baselines in the BigFix system. For each Baseline, the report has a
column for the Name, Sitename, Baseline ID, Affected Computers, Remediated Computers,
and Deployed Actions.

All Baselines
Find Baselines that start with: Search
(9 Baselines found. Displaying Baselines 1-)
MName & Sitename Baseline ID Affected Computers Remediated Computers Deployed Actions
Large Baseline ActionSite (QABES) 218 8 8 3
PF2 ActionSite (QABES) 3726 ar 0 0
PEZ ActionSite (QABES) 22020 26 0 0
QA Settings Test Suite DO ActionSite (QABES) 17524 ar 0 1
QA Settings Test Suite UNDO ActionSite (QABES) 17552 a7 0
QA Test Settings UNDO ActionSite (QABES) 18321 a7 0 0
rch5 test baseline ActionSite (QABES) 16312520 36 0 1]
tr ActionSite (QABES) 4508 3 5 2
ty ActionSite (QABES} 4507 a7 0 0

To create the All Baselines report:

1. Select Create > All Baselines. Click Next. A report is automatically generated, listing all the
Baselines across all BigFix databases.
2. Click on any Baseline to bring up an in-depth report.

Use the Current Report box in the left panel to Filter, Store, Export, Print, or Email this report.
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Action Summary Report

This report lists the actions that have been issued, grouped by BigFix Operator. For each action,
the report has a header for the Action ID, Name, Database, Status, Source Type, Sitename,
Reported, Operator, and Start Time. Depending on your Report options, you may also have
columns like Expired, Fixed, or Pending Offer Acceptance.

Action Summary

by bigfix

Find actions whose names start with: Search

(1311 actions found. Displaying actions 7-100)

Action DY Mame Dalabase Status Source  Sitename Reported Failed Fixed Mot Running Operator  Start Time
D Type Relevant

00-91 Gustom Action QABES  Expired Gustom m‘;’?ﬁ‘;& 4 0 4 0 0 bigfix %2.02?2-:01‘3’_-02

00-97  Custom Action QABES  Expired Custom f‘g}{‘;";s‘t]e 4 0 4 0 0 bigne 30070402

00-98  Custom Action QABES  Expired Custom fgg‘;’g;‘* 6 0 6 0 0 Highxs o 2000 0102

00-89 ?:;?UH Subscription to Custom Site 'Ryan QABES Open e — ,E\ﬁrénEEiS\t]e 25 0 25 0 0 bigix ig?s?s,:-%ds—ﬂz
00-103  Subseribe o Custom Site ‘bobo’ QABES  Open  Custom g}{‘;’éss‘;e 0 1 0 0 ignic i 210002
no-ips  Mssing Ofice Web Components -BES  oapes  Expired Fixlet  BESSupport 1 0 1 0 0 bigne 20070402
00-170  Default Subscription to Custom Site -ab’ ~ QABES  Open  Custom fgﬂ‘;’éss‘;e 27 0 27 0 0 bigfix %2?1?1‘%'19'02

To create the Action Summary report:

1. Select Create > Action Summary. Click Next.
2. From the displayed page:

3. From the list box, select any subset of BigFix operators to be in your report by Ctrl- and Shift-
clicking on them (only those operators who still have open actions are listed).

4. Check the boxes to include a column for each desired action status from those currently
applicable. These may include Expired, Failed, Fixed or Pending Offer Acceptance.

Click Next. All open actions are listed. You can sort the list by clicking the column headers.
Click on an Action ID link for a detailed report on that particular action.

Click on a Fixlet Name link for more information.

© N o u

Click on an Operator link to generate a new report for that particular operator.

Use the Current Report box in the left panel to Filter, Configure, Store, Export, Print, or Email
this report.
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Fixlet History Report

This report lets you analyze the history of specific Fixlet messages by displaying a graphical
representation of the progress of a Fixlet or set of Fixlets over time. The graph depicts both the
number of affected computers over time and those computers that have regressed (become
affected again). You can choose to group computers hourly or daily.

Fixlet History .-
9
B
7
&
5
4
3
2
i:
o
5/07 6/07 7/07
. Affected Computers Regressed Computers

FromlF_ariiest date jtolLatest date _j Go |

e Sitename FixietiD  Download Size Source Severity
BES Clients Restricted by License Expiration BES Support 4 <no download= Important
MS04-011: Security Update for Microsoft Windows - Windows 2000 Enterprise Security 401107 6.82 MB Critical
M504-011: Security Update for Microsoft Windows - Windows NT Server Enterprise Security 401103 208 MB Critical

Restart Needed - Not Triggered by a BES Action BES Support 391 <no download> Moderate
Restart Needed - Triggered by a BES Action BES Support 390 <no download=> Moderate

(23 data points found. Displaying data points 7-23)

Affected Computers Regressed Computers Date

1 0 2007-04-02
1 1 2007-04-09
1 2 2007-04-18
2 3 2007-04-25
1 3 2007-05-08
1 3 2007-D5-18
1 4 2007-06-05
2 4 2007-06-06

To create the Fixlet History report:

1. Select Create > Fixlet History. Click Next.

2. To select the Fixlet sites to include in this report, select any Fixlets from the Fixlet list by Ctrl-
and Shift-clicking on them.

3. Group your computers by the hour or the day using the buttons at the bottom of the page.

A graph displaying the number of computers affected by these Fixlets over time appears. The y-
axis corresponds to the number of computers and the x-axis corresponds to the date. The chart
also displays the number of regressed computers (where the Fixlet has become relevant again).
Below the graph are a couple of pull-down menus that let you reset the starting and ending dates
of the charted time period. Fixlets are listed after the date options.

Use the Current Report box in the left panel to Filter, Configure, Store, Export, Print, or Email
this report.
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Relevant Issue History Report

This graphical report allows you to visualize the effectiveness of your BigFix system over time.
You set a time period, and choose to see data over an hour, day, or week.

Relevant Issue History
From 2007-04-03 00:00 to 2007-07-24 00:00
50000
~
40000 / |
[ |
30000 \f :
20000 { 1
i
10000 i 3
f { S
ol —— — T maae S L SR AS
5/07 6/07 /07
/| Relevant Issues || Total Computers
(105 data points found. Displaying data points 7-100)
Relevant Issues Total Computers Date Databases
1 27 2007-04-03  QABES
1 27 2007-04-05  QABES
1 27 2007-04-07  QABES
1 27 2007-04-08  QABES
1 27 2007-04-08  QABES
1 26 2007-04-10  QABES
1 26 2007-04-11  QABES
1 28 2007-04-12  QABES
449 33 2007-04-13 QABES
480 31 2007-04-14  QABES
480 31 2007-04-15 QABES
480 31 2007-04-16  QABES
45 32 2007-04-17 QABES

To create the Relevant Issue History report:

1. Select Create > Relevant Issue History. Click Next.
2. From the two pull-down menus:
a. Select the starting and ending date for the period of interest.
b. Select an averaging period from the three choices: hour, day or week.

3. Click Next. A graph appears, displaying the number of relevant issues and computers over
time. The vertical scale corresponds to relevant issues.

4. Click on any data point in the graph to display a text box with more details. The data appears
in tabular form, below the graph.

Use the Current Report box in the left panel to Filter, Configure, Store, Export, Print, or Email
this report.
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Average Relevant Issue History Report

This report is similar to the Relevant Issue History report. It divides the relevant Fixlet messages
by the total number of computers in order to get an average.

Average Relevant Issue History

From 2007-07-01 00:00 to 2007-07-24 00:00

h Relevant Fixlets per Computer
TIGIOT
S0.535Q838 70907 T4

TILDT TIAOT TF15/07 TI23 107

Relevant Flxlets per Computer

(30 dada poinrs fond, Disnfaying dals poinds 1-30)

Relevant Fixlets par Computer Date

TEAS 2007-07-01 00:00
Th 42 2007-07-02 0000
T8.18 2007-07-03 0000
mn 2007-07-04 00:00
7.4 200707085 00:00
B0 2007-07-D6 DD:0D
BaAT 2007-07-07 00:00

To create the Average Relevant Issue History report:

1. Select Create > Average Relevant Issue History. Click Next.

2. From the two pull-down menus, select the starting and ending date for the period of
interest.

3. Select an averaging period:

e Hour
o Day
e Week

4. Click Next. A graph appears, displaying the average number of relevant Fixlet messages per
computer over time.

5. Click on data points to see details.

Use the Current Report box in the left panel to Filter, Configure, Store, Export, Print, or Email
this report.

User's Guide 31 Copyright © 2009 BigFix, Inc.



BigFix® Web Reports

Unmanaged Assets List

This report displays data on unmanaged assets gathered from a third-party source.

Asset _ Database
D MName
i QABES
2 QABES
3 QABES
4 QABES
5 QABES
] QABES
7 QABES
8 QABES

Source
Name

NMAP

NMAP

NMAP

NMAP

NMAP

NMAP

NMAP

NMAP

Running

no

no

no

no

no

no

no

no

Unmanaged Assets List

(35 assets found. Displaying assets 1-35)

Client

Device Type

firewall

router

general
purpose

general
purpose

general
purpose

VolP gateway
router or
broadband
router or

general
purpose

VoIP gateway

IF Address

192.168.104.2

192.168.104.3

192.168.104 6

192.168.104.8

192.168.104.11

192.168.104.14

192.168.104.17

192.168.104.19

Last Scan
Time
(Server
Time)
5/18/2007
5:26:10 PM
5/18/2007
5:26:10 PFM
5/18/2007
5:26:10 PM

5/18/2007
5:26:10 PM

5/18/2007
5:26:10 PM

5/18/2007
5:26:10 PM

5M8/2007

12:14:00 AM Y&

5/18/2007
5:26:10 PM

MNewly
Discovered

no
no

no

no

no

no

SonicWall SOHO3 firewall

Redback SMS500 Redback MNetworks router AOS Release 5.0.3.8 -
5.040

Microsoft Windows 2003 Server, 2003 Server SP1 or XP Pro SP2

FreeBSD 4 7-RELEASE through 4.8-RELEASE (x86) or FreeBSD
5.0-RELEASE or AmigaOS Miami 3.0 or AmigaOS Miami 3.1-3.2 or
NetBSD 1.31through 1.6 or FreeBSD 4.1.1- 4.3 (x86) or FreeBSD 4.9 -
5.1 or UTStarcom F1000 wifi voip phone or Amiga0S 3.5/3.9 running
Miami Deluxe 1.0c

Linux2.4.0-2520

AudioCodes MP-108 VoIP Gateway FXS

Cisco 105 12.X or Conexant embedded or Draytek embedded or
FreeSCO Linux 2.0.% or Linksys embedded or Linux Linux 2.4.X or Linux
Linux 2.5.X or D-Link embedded or Siemens embedded

AudioCodes MP-108 VolP Gateway FXS

To create the Unmanaged Assets List:

1. Select Create > All Unmanaged Assets. Click Next.

2. Select the columns you wish to monitor for each unmanaged asset. Click Next. A list of
unmanaged assets is automatically generated.

3. Click on an Asset ID to bring up the Single Unmanaged Asset report.

Use the Current Report box in the left panel to Configure, Store, Export, Print, or Email this

report.
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All Operators Report

This report will list all operators, along with their privilege type, creation time, last Console login

time, count of administrable computers, and count of deployed actions.

All Operators

Name = Database
bigfix QABES
EvaluationUser uk

foo QABES
herman QABES
igor QABES
LikeTyler QABES
paul QABES
paulnobody QABES
Sharona QABES

Type Creation Time
Master Operator 4/2/2007 3:07 PM
Master Operator 7/18/2007 1:05 PM
Operator 4/18/2007 4:20 PM
Master Operatar 4/18/2007 4:20 PM
Operator 4/20/2007 11:28 AM
Master Operator 7/5/2007 3:28 PM
Operator 5/2/2007 2:19 PM
Cperator 5/2/2007 2:19 PM
Operator 6/2/2007 6:36 PM

Find operators that start with: Search

(12 operators found. Displaying operators 1-12)

Last Login
7/23/2007 7:28 PM
7/20/2007 11:54 AM
<none>

<none>

5/21/2007 4:35 PM
7/24/2007 10:55 AM
7/23/2007 11:14 AM
710/2007 B:41 AM
7/9/2007 2:33 PM

Custom Content

Enabled
Enabled
Enabled
Enabled
Disabled
Enabled
Enabled
Disabled
Enabled

Email Address

bigfix
evalUser@eval.org
foo@foo.com
bigfixedited
igorc@bigfix.com

bigfix

paul@bigfix.com
paulnobody@bigfix.com
my@sharona.com

Administrable Computers  Deployed Actions

ar

1311
]

EEN~No OO
x)

To create the All Operators report:

1. Select Create > All Operators. Click Next. A list of all operators is automatically generated.
Filtering the report will affect the computer and action counts.

2. Click on an operator to bring up the Single Operator report.

Use the Current Report box in the left panel to Configure, Store, Export, Print, or Email this

report.
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Hidden Items Report

This report displays all Fixlet messages, Tasks, Analyses, and Baselines that have been globally
hidden through the Console.

Hidden ltems

Hidden Fixlets

=l Hidden Tasks

(0 Tasks found. )

MName & Sitename Task D Affected Computers Remediated Computers Deployed Actions
=1 Hidden Baselines

(1 Baseline found. Displaying Baseline 1-7)

Name 4 Sitename Task ID Affected Computers Remediated Computers Deployed Actions

bh ActionSite (QABES) 4508 2 7 0

-] Hidden Analyses

(0 analyses found. )

Name & Sitename Database Activated By Time Activated Status

To create the Hidden Items report:
1. Select Create > Hidden Items. Click Next. A report is automatically generated, listing all the
hidden Fixlets, Tasks, Analyses and Baselines across all the BigFix database servers.

2. Sort the list by clicking on any desired column heading. The column headers are based on
your default user settings.

3. Click on any individual item to bring up an in-depth report.

Use the Current Report box in the left panel to Configure, Store, Export, Print, or Email this
report.

Blank Report

This report lets you name, describe and categorize a custom report. A report like this is actually
code that generates a printable report. It typically consists of HTML with embedded Relevance
commands. You can choose to make this report public or private. For more information on
creating a custom Blank Report, see the Advanced Topics section at the end of this guide.
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Additional Reports

BigFix Web Reports includes several reports that are used less frequently. This section presents
those reports.

Single Computer Report

This report presents information about any specific computer on your network. You access this
report by clicking on a computer name or ID in any list or report.

Computer "KOOKABURRA"
Computer Name: KOOKABURRA
Database: QABES
Computer ID: 1175551982
[# Retrieved Properties
[# Client Settings
[# Relevant Fixlets
[ Remediated Fixlets
[ Action Results.
# Analyses

[ Comments.

The report contains the following information:

(] The Name of the computer.
° The name of the Database corresponding to this computer.
° The ID of the computer, as defined internally by BigFix.

° Retrieved Properties: These are computer attributes that have been retrieved from
the BigFix Client. This list is sortable by Name and Value; just click on the appropriate
header. Click on an item in the Name column to bring up a report on that retrieved
property, displaying the distribution of that attribute throughout your network. Click on
an item in the Value column to bring up a report listing other computers with that
particular value.

(] Client Settings: These are special retrieved properties used by the BigFix system.

° Relevant Fixlets: This list can be sorted by clicking on the column headers. Click on
individual Fixlet messages for more details. Click on an entry in the Affected
Computers column to show the other computers that are also targeted by this Fixlet.

° Remediated Fixlets: These are Fixlets that are no longer reporting as relevant.

° Action Results: This is a list of the Actions that have been initiated on this computer,
along with their disposition. You can sort the list by clicking on the column headers.

° Analyses: These are all the Analyses that this computer is a part of, along with the
current status of each.

° Comments: Comments that have been entered for this computer.

You can sort the report by any of these lists by clicking on the column headings. Use the Current
Report box in the left panel to Configure, Store, Export, Print, or Email this report.
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Computers with a Retrieved Property Value

This report is available by clicking on the value of a Retrieved Property in any list or report. For a
given value of a retrieved property, there will be a list of computers.

Computers with "OS" value of "WinXP-2003 5.2.3790"
Find computers that startwith:l Search |

(6 computers found. Displaying computers 71-6)

Computer Name & Computer ID Database Last Report Time

KOOKABURRA 1175551982 QABES 2007-07-24 16:39:00
LAUGHINGTHRUSH 29784487 QJABES 2007-07-24 16:51:19
QOABES 4301372 QABES 2007-07-24 16:49:02
QABIG B50202349 QJABES 2007-07-24 16:53:59
TURTLEDOVE 1170551878 QABES 2007-07-24 16:40:10
XE45P2 1701272 QABES 2007-07-24 143748

This report has the following sections:

° A title based on the name and the value of the retrieved property.

° A list of computers.

Click on the column headers to sort the list. Click on an entry in the Computer Name or
Computer ID column to see a detailed report on that computer.

Use the Current Report box in the left panel to Filter, Configure, Store, Export, Print, or Email
this report.
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Single Analysis Results Report

This report displays information about any specific analysis. You access this report from the All

Analyses Report by clicking on any desired analysis in the list.

Analysis "BES Component Versions"

Name: BES Component Versions
Sitename: BES Support
Database: uk

Issuer: EvaluationUser
Time Issued: 2007-07-26 11:52:42
Status: Activated Globally

View Description
iew Computers

[ Results

(1 resuit found. 1 computer counted.)

BES Client Version & Count Percent
7.0:1.376 1 100.00%
(1 result found. 1 computer counted.)

BES Relay Version & Count Percent
Nat Installed 1 100.00%
(1 result found. 1 computer counted.)

BES Console Version & Count Percent
7.0.1.376 1 100.00%
(1 resuitfound. 1 computer counted.)

BES Server Version & Count Percent
7.0.1.376 100.00%

{1 result found. 1 computer counted.)
BES APl Version = Count Percent
Not Installed 1 100.00%

] Comments

(0 comments found. )
Cperator & Time Comment

The report has the following sections:

o A display of the analysis properties: Name, Sitename, Database, Issuer, Time

Issued, and Status.

(] A link to the description of the original analysis.

° If the analysis is activated on any computers in your network, there will a link to view

those computers.

° A table listing the results of the analysis across your network, including the computer

count and percentage for each result.

° Any comments written by operators regarding this analysis.
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Single Analysis Computers Report

This report lists all computers associated with any specific analysis, along with their properties.
Access this report by clicking the View Computers link in the Single Analysis Report.

Analysis Computers "BES Component Versions"

Name: BES Component Versions
Sitename: BES Support
Database: uk

Issuer: EvaluationUser
Time Issued: 2007-07-26 11:52:42
Status: Activated Globally

View Description
View Results
Computer Mame & BES Client Version BES Relay Version BES Console Version BES Server Version

{1 computer found. Displaying computer 1-7)
QAUKEMACHINES  7.0.1.376; Mot Installed; TO01376; 7.0.1.376;

This report contains the following sections:

° The same analysis properties as in the Single Analysis Report.
(] A Description of the report.
(] A link back to the Single Analysis Results Report.

° A list of Analysis results, grouped by computer.

There may be multiple results for an Analysis; if so, the report will show a column for each result.
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Single Fixlet Report

This report provides information about any specific Fixlet. Access this report by clicking on any
Fixlet link available in a report, such as the All Fixlet List or Relevant Fixlets.

Fixlet "Login Needed"

Fixlet Name: Login Needed

Sitename: BES Support
Fixlet ID: 240

Category: Computer Support
Download Size: <no download>
Source: BigFix

Source ID: <Unspecified>
Source Severity: Moderate

View Description
e

[ Affected Computers

{2 computers found. Displaying computers 1-2)
Computer Name & Computer ID

QABES 4301372
QAVISTAT 12269237

[l Remediated Computers

(4 computers found. Displaying computers 1-4)

Computer Name Computer ID
LAUGHINGTHRUSH 29784487
NT_SERVER 2878530
ROBIN 16306243
TURTLEDOVE 1175551878

Database

QABES
QABES

Database
QABES
DABES
QABES
QABES

Last Report Time

2007-07-26 12:59:42
2007-07-13 13:44.05

Last Report Time

2007-07-26 12:56:13
2007-07-26 12:55:59
2007-07-26 12:36:06
2007-07-26 12:55:34

Time Detecled

2007-07-1911:08:45
2007-05-10 23:14:44

Time Remediated

2007-05-08 15:17:34
2007-07-20 12:06:09
2007-06-15 14.59:57
2007-04-09 16:56:13

The report has the following sections:

° A display of the Fixlet message properties, including its Category and Severity as
determined by the author of the Fixlet message.

° A progress bar.

If the Fixlet action has already been initiated, a real-time progress bar displays the current state of
the deployment across the network. At zero percent compliance, the bar is gray. As computers
are remediated, a green progress bar moves from left to right.

° A list of all the Affected Computers that are currently reporting relevance for this

Fixlet.

° A list of Remediated Computers represents computers that were once affected, but

are now fixed.

Note:  Even when a patch is applied independently of the BigFix system, that computer
will still be recognized as remediated and will be listed in this report.

(] A list of all open Actions—those that have already been issued and are still in
progress for the given Fixlet message.

o A list of Operator Comments.

° A column displaying the Visibility of the Fixlet for various databases.

You can sort any of these lists by clicking on the column headings. Use the Current Report box
in the left panel to Filter, Configure, Store, Export, Print, or Email this report.

User's Guide

39 Copyright © 2009 BigFix, Inc.



BigFix® Web Reports

Single Task Report

This report provides information about any specific Task. It can be accessed by clicking on any
Task link in a report, such as the All Task List.

Task "BigFix AntiVirus - Enable Client Controls"

Task Name: BigFix AntiVirus - Enable Client Controls
Sitename: BigFix AntiVirus

Task ID: 29

Category: Administration

Download Size: <no download>

Source: BigFix

Source ID: <Unspecified>

Source Release Date: 4/3/2007

Source Severity: <Unspecified>

View Description
=] Affected Computers

(2 computers found. Displaying computers 1-2)

Computer Name Computer ID Database Last Report Time Time Detected
WINZK-PRO-GOLD 6828835 QABES 2007-07-26 12:55:24 2007-07-24 16:38:56
WINZK-PRO-GOLD 8844975 QABES 2007-07-26 12:54:07 2007-07-24 23:57:21

=] Remediated Computers

(1 computer found. Displaying computer 1-1)
Computer Name & Computer ID Database Last Report Time Time Remediated
ROEIN 16306243 QABES 2007-07-26 12:36:06 2007-06-13 16:54:23

[=] Action Results

(1 action found. Displaying action 1-1)
Action ID &~ Name Database Status Reported Fixed Failed Operator Start Time
00-21869 EigFix AntiVirus - Enable Client Controls  QABES Expired 1 1 1] bigfix 2007-06-13 16:48:15

The report has the following sections:

° A display of Task properties, including its category and severity (as determined by
the author of the Task).

° A display of Affected Computers, a list of all the computers that are currently
reporting relevance for and no longer reporting relevant.

Note:  Even when a patch is applied independently of the BigFix system, that computer
will still be recognized as remediated and will be listed in this report. Unlike Fixlet
messages, Tasks are often designed to implement a policy, not fix vulnerabilities.
As such, a Task might never expire and remediation may be largely irrelevant.

(] A list of all open Actions—those that have already been issued and are still in
progress for the given Task.

o Comments by various operators about the Task.

° A column displaying the Visibility of the Task for various databases.

You can sort any of these lists by clicking on the column headings. Use the Current Report box
in the left panel to Filter, Configure, Store, Export, Print, or Email this report.
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Single Baseline Report

This report provides information about any specific Baseline. It can be accessed by clicking on
any Baseline link available in a report, such as the All Baseline Report.

Baseline "Jul 2007 Patch Release"

Baseline Name: Jul 2007 Patch Release
Sitename: ActionSite (QABES)
Baseline ID: av2s

Source: Internal

Source Release Date: 417/2007

Created by: bigfix

View Description
0.00%
[# Components
[+] Affected Computers
[+ Remediated Computers
[+] Action Results

¥ Comments

The report has the following sections:

° A display of Baseline properties, including name, sitename, source, and creator.

° A display of the Components making up the Baseline. These are typically groups of
Fixlets, Tasks and other Baselines.

° A display of Affected Computers—those computers that are currently reporting
relevance for this Baseline.

° A list of Remediated Computers representing computers that were once affected by
some component of this Baseline, but are now fixed.

Note:  Even when a patch is applied independently of the BigFix system, that computer
will still be recognized as remediated and will be listed in this report.

A list of all open Actions — those that have already been issued and are still in
progress for the given Baseline.

° Comments by various operators about the Baseline.

You can sort any of these lists by clicking on the column headings. Use the Current Report box
in the left panel to Filter, Configure, Store, Export, Print, or Email this report.
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Action Status Report

This report provides information on any one action. It lists the computers on which the action was
performed, and the status of the action on the computer. To access this report, select any Action

ID in a list or report.

Action "Action Language - Download"

Action ID: 00-3466

Action Name: Action Language - Download
Source Type: Custom

Status: Stopped

Start time:  2007-04-09 14:55:50
Operator: bigfix

[l Results

(5 computers found. Displaying computers 1-5)

Computer Name & Computer ID Database
Intel Mac Mini7?s Computer 1175551937 QABES
KOOKABURRA 11755651982 QABES
LAUGHINGTHRUSH 29784487 QABES
QAVISTAT 12269237 QABES
TURTLEDOVE 1175551878 QABES

[El Comments

(0 comments found. )
Operator & Time

Last Report Time

2007-07-08 12:22:48
2007-07-26 13:52:01
2007-07-26 13:49:44
2007-07-13 13:44:05
2007-07-26 13:45:07

Result

Pending Downloads
Fixed

Pending Downloads
Pending Downloads
Fixed

Comment

The report contains the following information:

° A header including: Action ID, Action Name, Source Type, Status, Start time, and

Operator.

° A list of the Action Results by computer. You can sort the list by clicking on the
column headers. Click on the individual computer links for more information.

® Operator Comments.

You can sort the list by clicking on the column headings. Use the Current Report box in the left
panel to Filter, Configure, Store, Export, Print, or Email this report.
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Single Operator Report

This report is available by clicking on the Operator link in the All Operators report or the Action
Summary report.

Operator "bigfix"

Mame: bigfix

Type: Master Operator

Creation Time: Mon, Apr 2, 2007 at 3.07 PM
Last Login Time: Thu, Jul 26, 2007 at 10:56 AM
Custom Content: Enabled

Email: bigfix

[+] Administrable Computers
[+] Deployed Actions

[+] Custom Fixlets

[+] Custom Tasks

+] Comments

It contains the following sections:

° Information about the operator: Name, Type (Master Operator or Operator), Creation
Time, Last Login Time, Custom Content (Enabled or not) and the operator’'s Email
address.

° A list of computers the operator has administrative privileges on.
° A list of all Actions that the operator has deployed.

° A list of all Fixlets the operator has created.

° A list of all Tasks the operator has created.

° Comments made by this operator.
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Filtering Reports

The Current Report box is available in the left navigation bar when a report displays.

Current Report b

I <no filter= |

Configure Report
Store Report
Export to CSV
Frintable Yersion
Email Report

At the top of the panel is a drop-down menu listing the existing filters and options. All
administrators—not just the creator of the filter—have the ability to delete a filter from this list.
Some options from the Current Report box are:

° Filter Report: This drop-down menu lets you select from, add, and manage the list of
existing filters. These filters will help to narrow down your reports to just the items of
greatest interest to you. Each Filter shows the name of its author in parentheses.

° Configure Reports: This interface allows you to edit the parameters of a report. From
any report, click the Configure Report link in the action box. The report criteria are
presented, enabling you to edit them.

° Store Reports: You can save the criteria you used for a report. From any report, click
the Store Report link in the Current Report box. To store a report, provide this
information:

o Report Name. Enter a name (less than 100 characters) for the report. This
becomes a sortable field in the report list.

e Description. Enter a short description (less than 1,000 characters) for the report.

e Category. Enter a category for this report. The category should reflect the report
type, such as Action Summary or Relevant Fixlets.

e Visibility. Check a button to make the report Public or Private.

° Export to CSV: Click on this to export your report to any program that can accept files
in Comma Separated Value (CSV) format. You will be presented with an Open/Save
dialog, allowing you to view or save the file.

° Printable Version: This link enables you to format a report for printing. Select File >
Print to output your report.

° Email Report: This link allows you to email the current report. Email settings must be
set up prior to using this feature.
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Creating Filters

The Filter Report selection in the Current Report box includes options to create new filters and
manage existing filters. Filters can be applied to any report, including the Overview. You can also
select a previously saved filter and apply it to your current report. If another filter is already in use,
BigFix Web Reports will combine the two filters.

Build a filter by selecting properties with specific values and adding them to the filter. The
properties and values will be filtered based on the current filter. For example, if a Fixlet Sitename
filter is added for 'BES Support’; then when you look at the values for Fixlet names, you will only
see Fixlet messages from the 'BES Support' site. When you are satisfied with a filter, click Done
to use the filter immediately. It will be lost if any of the navigation links are clicked. Click Save
Filter to store a filter for future use.

To create a report filter, you need to add or remove filter properties one at a time. The filter can
be used, saved, or cleared at any time.

There are several filters from which to choose:

° Saved Filter. Select a previously saved filter.
° Database. Filter reports by the specified database.
° Site. Filter reports based on the site.

(] Computer. Filter reports based on computer properties such as Directory, Group,
Last Report Time or Retrieved Property.

(] Fixlet / Task / Baseline / Analysis. Filter reports based on various properties, such
as Name, Sitename, Category, Source, Severity, CVE, SANS, Comments or Source
release date.
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To build a filter:

1. Ensure the Current Report box is visible in the left context panel. You may have to click the

vertical blue bar to open this panel.

2. Select the Create Filter option from the pull-down menu. This will bring up the Create Filter

page.

Create Filter

B Saved Filter
Name

El Database
Name

Bl Site
MName

El Computer
Active Directory
Computer Group
Last Report Time
F Retrieved Property

Name

Sitename

Category

Source

Severity

CVE

SANS

Comment

Source release date

Bl Fixlet/ Task / Baseline / Analysis

3. Onthe Create Filter page:

a. Select afilter class by clicking on the plus sign (+) next to it.

b. Depending on which filter class you select, you will be presented with another page
to pick the filter value. There may be a pull-down menu letting you choose to Include

or Exclude the selected values.

c. Click the plus (+) or minus (-) buttons to add or delete a property.

d. If you change your mind, click the Back button to choose another filter.

4. The program displays your selected filter, along with the other previously defined components

of the filter.

5. Continue adding properties and values until the filter is complete.
6. When you are finished, choose one of the following options:

7. Click Done to use the filter immediately in the current report.

8. Click Save Filter to save the filter for future use.

9. Click Clear Filter to start over.
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Managing Filters

Filters are used to customize reports, allowing you to focus on any particular subset of the
database. To view, modify, or delete a saved filter, click the Manage Filters option in the Filter
Report drop-down menu. You will see a list of the existing filters, allowing you to modify any of
them. All administrators—not just the creator of the filter—have the ability to edit, delete, or
rename a filter from this list.

Manage Filters

Expand All | Collapse All |

EIBES Clients Restricted by Seat Count [edit] [delete] [rename]
Created by user bigfix'
Bl include Fixlets:
BES Clients Restricted by Seat Count

@ fixlet [edif] [delete] [rename]
® mwy filter [edit] [delete] [rename]
# non-uk [edit] [delete] [rename]
Euk [edifl [delete] [rename]
Created by user 'bigfix’
Bl include property ‘ukemachines’:
Thu, 05 Apr 2007 01:29:49 +0100

To manage filters:

1. Select Current Report > Filter Report > Manage Filters.

2. Click the Expand All button to see the details of each filter.

3. From the list of Filters, click the Edit link to modify the filter properties.
4

Click the Delete link to delete a saved Filter.

WARNING! If you delete a filter that is a part of an existing report, you may change the interpretation of that report and
generate a larger than expected listing.
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Scheduling Activities

You can create Scheduled Activities to email and archive specified reports after a given time
period or when certain conditions are met. This allows you, for instance, to receive automatic
updates of critical Fixlets via emalil, or to regularly back up audit reports.

Scheduled Activities

(5 activities found. Displaying activities 1-5)

ID «  Creator Type Name Options Start Time Expire Time Next Time Period
] bigfix Stored Report Action List {Admin) Archive 5/9/1963 4:53 AM None Disabled 1 day
- .2 paul Stored Report Action List {Admin) Email 6/78/2007 71.07 AM None Disabled 1 day
| paul Alert Alert3 Email 6/15/2007 1:40 PM None TI24/2007 11:19 AM 1 day
I~ 8 paul Stored Report All Computers (paui) Email 6/15/2007 1:43 PM None Disabled 1 day
[ {88 paul Stored Repaort All Fixlets (paul) Email 6/18/2007 11:59 PM None TI26/2007 11:59 PM 1 day

Select All Clear All I

MNew | Edit | Enable | Disable | Delete |

The columns on the page include:

° Select All: Places a checkmark in front of each Scheduled Activity in the list.
° Clear All: Clears all the check marks on the list.

° New: Allows you to create your own Scheduled Activity.

° Edit: Allows you to edit the properties of the Scheduled Activity.

° Enable: Allows the selected activity to perform on schedule.

(] Disable: Prevents the activity from running until enabled again.

(] Delete: Deletes the selected (checked) activities.

A scheduled activity creates a report on a specified schedule. The interface has four sections,
specifying the time range, the activity report, the activity trigger for the schedule, and the
activity actions that should be taken.

To schedule an activity:

1. Click the Schedule link, and then click the New button.
2. The Create Scheduled Activity page appears.
3. Select atime range for the scheduled activity. This setting defines the window during which

the schedule remains in effect. If you do not select an expiration time, the activity stays open-
ended.
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4. In the Activity Report box:

Activity Report:
Type:

|| Action List (Admin) =

Format;
* HTIML
" csv

a. Select areport type: Report, Overview, or Alert. A report produces a detailed
graphic/tabular output, an overview summarizes the information graphically, and an
alert typically sends a report as an email.

b. Select a stored report from the pull-down menu. The menu includes all public and
private reports to which you have access.

c. Select either HTML or CSV format for your report.
5. In the Activity Triggers box:

Activity Triggers:

* Generate report every: Il I Days j
" Generate report on every refresh (currently every 600 seconds)
" Generate report once

™ Match Relevance conditions

[Test]

= Generate report when relevance is true

" Generate report when relevance becomes true
" Generate report when answer changes

¥ Send emailistore archive only when repart has changed
I Include trigger information

a. Select how often to generate the report: during a specified interval, after every data
refresh, or once.

b. Enter any relevance conditions necessary for the report to run.
Select whether to email or archive the report only when it has changed.

d. Check the box labeled Include trigger information to embed the trigger criteria in
the report itself.
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6. In the Activity Actions box:

Activity Actions:
[ Email [ Edit]
To:
Mike Ottum <mike_ottum@bigfix.com>>
new <new@new.com:
Operators <operators@bigfix.com>
>> |
Fram: |b|qf|x
Subject: |[EL5 Systemn] Report Motification
Text:
¥ Include report output
[ Include link to current report
[ Include link to archive report
I Archive
Folder name: |12 [ View Existing Folders ]

[ Limit the number of archives stored

S Only keep archives for | Days j
" Limit archives to MB
& Only keep entries

I Customized Executable (7]

Executable: | BESEmailer.exe j

Arguments:

Select to whom you wish to email the report.
Select to have the report attached or linked to the message.

Select whether or not to archive the report.

a o T p

The number of archives can be limited by how old they are, how much size they take
up, or how numerous they are.
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7. Enter any customized executable you want. Custom executables must reside in the correct
directory (as specified in the registry). The default directory is:

C:\Program Files\BigFix Enterprise\BES Server\BESReportsData\CustomExe.

8. There are several reserved parameters that can pass information about the activity to the
executable:

e <activityname>: the scheduled activity's name
o <reportfile>: the file containing the generated report
e <activitycreator>: the scheduled activity's creator

9. Click Submit.
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Configuring Email Settings

Click the Email tab to configure email settings. Only a Web Reports administrator can edit email
settings. There are two buttons on this page:

° Test: Lets you verify the email server settings by sending a test message.

° Edit: Allows you to edit the email settings.

This page also has a link to a list of Email addresses. Click this link to bring up a page that helps
you to manage a list of email address.

Editing Email Settings
To edit email settings:

1. Click the Email tab.
2. Click Edit on the Email Settings page.

3. Enter your SMTP server and the default domain.

The default domain will be used when you do not specify the domain along with the email
address (i.e. you do not add “@domainname.com” to the email address).

Adding Email Addresses

To add a new email address:

1. Store frequently used email addresses by clicking the My Email Addresses link in the main
Email Settings page.

2. Click Add New Contact to add a contact’'s name and email address.
Click the New button to store an email address.

4. This page also allows you to delete addresses: check the box next to the name and click the
Delete button.

5. When you finish with your list, click Done.
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Managing User Accounts

The User Management page has two different interfaces, depending on how you log on to the
program. If you log on as a Web Reports Administrator, the full list of settings will be available,
including user management. If you do not have an Administrator account, you will only be able to
edit your own personal settings. To view the User Management page, click the Users tab.

User Management

(& users found. Displaying users 71-8)
Mame &

admin
bigfix
igor
normal
paul
restricted
test

test2

Add New User
User Options

Type

Administrator
Administrator

Mormal

Mormal

Restricted

Restricted (Read-0Only)
MNormal {Read-Cnly)
Restricted

Cptions

Edit
Edit
Edit
Edit
Edit
Edit
Edit
Edit

Delete

Delete
Delete
Delete
Delete
Celete
Delete

The User Management page lists users in a table that contains links in the Options column:

(] Edit: This link allows you to edit the settings for the associated user.

(] Delete: This link lets you delete the associated user from the Web Reports list. You
must be logged into Web Reports as an administrator to delete users. Note that you
cannot delete your own account.

There are two other links on this page:

° Add New User: Brings up the Create User page, which prompts you to provide a
password and define any user restrictions.

° User Options: Brings up the User Options page, which allows you to restrict user
access to certain Web Reports features.
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Adding a New User

To add a user to the Web Reports system, you must log on as an Administrator.
Follow these steps to add a user:

1. Select Users > Add New User. The Create User page appears.

Create User

Username: l

Password: I

Re-type Password: I
¢ Administrator
" Normal user

" Restrict normal user by Console Operator:

3

¢ Restrict normal user by saved filter:

BES C

[ Restrict user to Read-Only mode. (Disables creating repaorts, scheduling activities, and saving filters.)

Add New User | Cancel |

2. Choose an appropriate Username and Password for the new user. Type the password twice
to verify it.

3. Select one of the four available buttons to grant privileges to the user:
e Administrator: Grants top-level privileges, with the ability to create additional users
and set database configurations.

o Normal user: Grants ordinary privileges allowing the user to view the data, but not to
create other users or set database configurations.

e Restrict normal user by Console operator: Grants privileges dictated by the
Console Operator. This restricts the user to those computers approved by a specified
Client Administrator.

e Restrict normal user by saved filter: Grants privileges based on a saved filter. This
option will not show up if there are no saved filters to display.
4. Check the box if you want to Restrict user to Read-Only mode.

Restricting users to read-only mode means that the users cannot create reports, schedule
activities, or save filters.

6. Click the Add new user button.
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Editing User Accounts

When editing user accounts, different options are presented depending on whether you are
editing your own settings or someone else's. If you are not logged in as an administrator, you
cannot edit other users’ accounts, and your interface is limited to your private user page. To
change the parameters of a user, select the Users tab, and then click the Edit link in the row of
the desired user.

Edit User

Lisername: igar
Administrative account: Mo
Fead-Only: Mo

View unrestricted.

Change privileges Change password Cancel

Regardless of administrative privileges, if you are editing your own settings, you can:

° Change your password. Click this button to bring up the Change Password page.
Enter your old password, then enter your new password and confirm it.

° Change your default settings. You can only access your own personal defaults, not
those of other users.

If you are logged in as an administrator, and editing a user other than yourself, can:

(] Change the user’s privileges. This allows you to grant the user administrative access
or to filter the user’s view based on a specific Console user.

(] Change the user’s password. Click this button to bring up the Change Password
page. Enter a new password and confirm it.
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Setting User Options

You can set user options by clicking User Options from the User Management page.

User Options

[+ Allow normal users to store public reports.

¥ Allow normal users to view custom reports created by other normal users (Admin reports are viewable by everyone).
[+ Allow normal users to create, edit, and import custom reports.

[ Allow normal users to view all filters.

[+ Allow users restricted by Console operators to view all operators.

[+ Allow users restricted by Console operators to view all local analyses.

Password Complexity Rule:
|.6,2551
(default: {6, 255})

Password Complexity Description:
IPassword must be between 6 and 255 characters.
(default: Password must be between & and 255 characters.}

Submit I Cancel I

To change user options:

1. Check the appropriate boxes for the selected Web Reports user:

e Allow normal users to store public reports. This is on by default. If it is turned off, then
non-administrative users will not be able to save public reports, but they will still be able
to access public reports and save private reports.

e Allow normal users to view custom reports created by other normal users. This is
on by default. Custom reports created by the Admin are always viewable.

e Allow normal users to create, edit, and import custom reports. This is on by default.
If turned off, non-administrative users will not be able to create, edit, and import custom
reports.

e Allow normal users to view all filters. This is on by default. If turned off, non-
administrative users will only be able to view filters they have created themselves.

o Allow users restricted by Console operators to view all operators. This is on by
default. If turned off, restricted Web Reports users will not be able to view other
operators.

e Allow users restricted by Console operators to view all local analyses. This is on by
default. If turned off, restricted Web Reports users will not be able to view the local
analyses.

2. Set the rules for the required complexity of the Web Reports password. By default,

passwords must be between 6 and 255 characters. You can change these limits, depending
on your desired level of security.
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Changing User Privileges

An Administrator can change the privileges of other Web Reports users.

Change Privileges

Username: paul

" Administrator

" Normal user

" Restrict normal user by Console Operator:
bigfix A
EvaluationUser
foo |
herman b
igor

LikeTyler '
paul v

' Restrict normal user by saved filter:

ggg (bigfix)
group (bigfix)
my filter (bigfix)
non-uk (bigfix)

OAEMACHINES (bigfix)

qaq (bigfix)
uk (bigfix)

Submit ! Cancel I

v

I Restrict user to Read-Only mode. (Disables creating reports, scheduling activities, and saving filters.)

To change user privileges:

1. Click the Users tab, and then select the Edit link associated with the desired user.

2. Click the Change privileges button and follow these steps:

3. Select from one of these four privilege levels:

e Administrator. Grants top-level privileges, with the ability to create additional users and

set database configurations.

o Normal user. Grants ordinary privileges to view the data, but not to create other users or

set database configurations.

e Restrict normal user by Console operator. Grants privileges dictated by the Console
Operator. This restricts the user to those computers approved by a specified Client

Administrator.

e Restrict normal user by saved filter. Grants privileges based on a saved filter. This

option will not show up if there are no saved filters to display.

4. Check the appropriate box if you want to Restrict user to Read-Only mode. Restricting
users to read-only mode means that the users cannot create reports, schedule activities, or

save filters.
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Editing Your Own User Preferences

User Preferences are available when you edit your own user account from the User
Management page. This page allows you to customize your default options for BigFix Web
Reports.

User Preferences

Top level defaults

Select the initial page after logging in.
I Overview ~|

I Disable graphs in reports.
&5 Always show filter minimized by default.

Input the number of results per page, between 10-1000.
|1r:|r:|

Fixlet List Report Defaults

Check the columns available in the Fixlet List report
r Category

F Download Size

I Source

I Source ID

I Source Release Date

F source Severity

I cve

[~ SANS

Fixlet History Report Defaults

Input the number of hours to skip when sampling points.

|24 hours

F Connect all data points.

Submit | Cancel

To edit your user preferences:

1. Click the Users tab.
2. From the User Management page, click the Edit link associated with your account.

Click the button labeled Change default settings. This button is only available when you are
editing your own user account.

A new page appears with several options for you to customize.
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To customize your options:

In Top Level Defaults:

Set the initial page you see after logging in. By default, this is set to Overview.
Choose whether to disable graphs in reports.

Choose whether to always show filters minimized by default.

Enter the number of results to see per page. The default is 100.

2N o

In Fixlet List Report Defaults select which Fixlet properties you want to include in your
reports.

7. In Fixlet History Report Defaults:
a. Enter the number of hours to skip when sampling points.

b. The hours to skip while sampling points represents how many hours can elapse
between data samples before disconnecting the corresponding points on the graph.

c. Choose whether to select Connect all data points. If you select this option, the hours
to skip parameter will be ignored.

8. Click Submit to update and save your default settings.
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Managing Databases

You can manage the databases from which Web Reports aggregates information. Click on the
Databases tab to bring up the Database Settings page. There are several links on this page:

° Edit: Allows you to edit the settings for a selected Database. Brings up the Edit
Database page.

° Delete: Lets you delete the selected Database from the Web Reports aggregation. If
you want to ignore the database but keep the database connection information
available, you can disable the database. To disable a database, click its Edit link and
check the Disable database box.

(] Validate: Checks the validity of the Database by running a connection test.
° Add New Database: Lets you add a new Database into the aggregation group.

° Validate All Database Connections: Lets you validate all of the aggregated
databases. This link attempts to connect to all the databases and spawns a small
window to monitor the progress. If a problem occurs, an error message is issued. If all
goes well, a check-mark appears along with a message indicating success.

° Database Options: Allows you to set options for a selected database. One option
exists on this page: Disable relevance evaluation. It is unchecked by default. If
checked, all relevance evaluation in custom reports and in any scheduled activities
will be disabled.

(] Cache Settings: Displays information about the database cache in memory. It
displays the last time the cache was written to a file on disk for each database. It also
allows you to change how often the cache is to be refreshed. Finally, it gives the
option of writing the cache to disk, and if so, how often it should be written to disk.

° Refresh Cache: Starts a full refresh of the database cache.

° View Errors: Allows you to view all recent errors that have occurred in the Web
Reports system. These errors usually occur in the background and can affect the
integrity of the data. They are usually related to connection problems or other
problems with the database. Only an administrator may clear these errors.

o Local Database Settings: Shows the local database DSN and the local BigFix
Reporting Server.
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Adding a Database

You can add other BigFix databases to your reports. This allows you to create aggregate reports
covering hundreds of offices, each with thousands of computers.

There are two authentication types from which to choose:

° Windows Authentication is somewhat more complex to set up, but provides a more
secure solution. To use Windows Authentication, the Windows domain user that Web
Reports runs under must have credentials and access to the database. Web Reports
runs as a service; it will run as the LocalSystem account by default. To run the Web
Reports Server as a different user, log on to the Web Reports Server as a domain
user with permissions on the database.

° SQL Server Authentication is simple but less secure than Windows authentication
because the username and password are stored in plain text in the registry. For this
option, the username must refer to a SQL Server user with permissions on the
database. A console user’'s name and password will also work, but this method is
equally insecure because the password is also stored in plain text in the registry.

To add a database:

1
2
3.
4

o

Log in as an administrator.
Select Databases > Add New Database.
Enter a Server Name that will be used to identify the database.

Choose a method to connect to the database. If Use a default DSN-less connection is
selected, enter the server IP. If Use a system DSN is selected, enter the DSN name of a
system DSN that connects to the server.

Choose the Authentication Type that will be used to connect to the database.
At the bottom is the default Web Reports URL, which points to the Web Reports Server.
If necessary, change the URL for your Web Reports Server. Because the server's URL is

established when installing the product, you will not need to change this setting unless you
add a database to your installation.
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Editing Database Connection Settings

The Edit Database page allows you to change connection settings and disable the database.
To edit database connection settings:

1. Select the Database tab and click the Edit link next to the desired database name.

2. The Edit Database page is displayed.

3. Choose a method to connect to the database:

e If Use a default DSN-less connection is selected, enter the server IP.

e If Use a system DSN is selected, enter the DSN name of a system DSN that connects to
the server.

4. Choose the Authentication Type that will be used to connect to the database.

e Windows Authentication
e SQL/Server Authentication.

Enter the Web Reports URL, which defaults to the Web Reports Server.

6. Click the Disable database checkbox to exclude this database from all reports. The status of
this checkbox applies across all Web Reports users.

7. Click Submit.
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Part Four

Resources

Advanced Topics

This section presents tasks unlikely to be needed by the typical user, but which may be of use to
advanced users with specific customization needs.

Exporting Web Reports as PDF Documents

Web Reports 7.1 and later has the ability to generate PDF format documents for printing or
emailing. PDFs can be sent by clicking on the Email Report link or by setting the PDF format
option when creating or editing a scheduled activity, or by simply exporting the report as a PDF
document.

Automatic Installation

There are two Tasks in the BES Console that are designed to help you get started. Select the
Task tab and search for the following Task IDs:

L] Task ID: 602: BES Web Reports: Enable PDF Reports - Part 1 of 2
L] Task ID: 603: BES Web Reports: Enable PDF Reports - Part 2 of 2

Execute the Actions in these Tasks to automatically install the PDF generator.
Manual Installation

You may also install the PDF functionality manually on the server hosting the
BESWebReportsServer service. Here's how:

1. |Install Internet Explorer 7, if it is not already installed.

2. Install Flash Player for Internet Explorer (32-bit version, even on an x64 machine).

3. Add your Web Reports host to Internet Explorer's trusted sites list for the system account.
4.

In the registry:

a. Add akeyto HKEY_USERS\[User account running Web Reports
service]\Software\Microsoft\Windows\CurrentVersion\Internet
Settings\ZoneMap\Domains with the fully qualified domain name of your Web Reports
host. For example, if you access Web Reports at http://bes.example.com and run Web
Reports under the SYSTEM account, you would add the key HKEY_USERS\S-1-5-
18\Software\Microsoft\Windows\CurrentVersion\Internet
Settings\ZoneMap\Domains\bes.example.com.

b. Add a REG_DWORD value (under the key you just added) named http and set it to 2.
c. Add a REG_DWORD value (under the key you just added) named https and set it to 2.

5. Add a PostScript file printer named BES Web Reports Printer that prints to the port
C:\Program Files\BigFix Enterprise\BES Server\BESReportsData\ArchiveData\ __pdfiout.ps.

6. Install the 32-bit (x86) version of GhostScript (version 8.60) from the site:
http://pages.cs.wisc.edu/~ghost/doc/GPL/gpl860.htm.
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7. Append the following strings to the end of your PATH variable under "System variables"
(Right-click on My Computer, Properties, Advanced, Environment Variables).

8. For 32-bit versions of Windows:
e C:\Program Files\gs\gs8.60\bin;
e C:\Program Files\gs\gs8.60\lib;
9. For 64-bit versions of Windows:
e C:\Program Files (x86)\gs\gs8.60\bin;
e C:\Program Files (x86)\gs\gs8.60\lib;
10. Create the following registry string values (REG_SZ) in the
HKLM\Software\BigFix\Enterprise Server\BESReports registry key.

e PDFEnable: 1
o PDFPrinterName: BES Web Reports Printer
e PDFPostScriptPath:

e For 32-bit versions of Windows:
C:\Program Files\BigFix Enterprise\BES Server\BESReportsData\ArchiveData\ _pdfi
out.ps

e For 64-bit versions of Windows:
C:\Program Files (x86)\BigFix Enterprise\BES Server\BESReportsData\ArchiveData\
__pdflout.ps

11. Restart Windows (this is necessary to ensure that the PATH variable changes are picked up).
Registry Settings
All settings are REG_SZ values in HKLM\Software\BigFix\Enterprise Server\BESReports:

Setup

e PDFEnable (Setto "1" to enable PDF generation)
PDFPostScriptPath
o PDFPrinterName

Logging
e PDFLogPath

Default Header and Footer

e PDFDefaultHeader
e PDFDefaultFooter

Using an unprivileged user to render the report and generate the PDF

e PDFUseUnprivileged (Set to "1" to use the account specified by the values below)
e UnprivilegedUsername
e UnprivilegedDomain
e UnprivilegedPassword

User's Guide 64 Copyright © 2009 BigFix, Inc.



BigFix® Web Reports

Timeout Settings

e PDFReportTimeout (in minutes, default 60)
PDFPrintTimeout (in minutes, default 60)

Internet Explorer post-rendering pause

e PDFPause (in seconds, default 10, gives Flash components time to initialize before

printing

Header / Footer Print Codes

When printing a PDF file, you can specify header and footer information in the Page Setup dialog.

Page Setup

Paper
Size:

= 5
Source:

| Automatically Select v

Headers and Footers
Header

&wibPage &p of &P
Footer
&uébéd

Drigntation Margins (nches)
(@ Portrait Left: 075 Right: 075

() Landscape Top: 075 Bottom: 0.75

[ ok || cance |

he

The codes used in the Header and Footer fields of this dialog allow you to add information about

the title, URL, date and more. The list of possible codes includes the following:

&wW Window title

&u Page address (URL)

&d Date in short format specified by Regional Settings in Control
Panel

&D Date in long format specified by Regional Settings in Control
Panel

&t Time in the format specified by Regional Settings in Control
Panel

&T Time in 24-hour format

&p Current page number

&P Total number of pages

&& A single ampersand (&)

&b Separates preceding and following text into different sections.
Example: left &b center &b right

text Custom text (can be used in combination with printing codes)
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Troubleshooting PDF Generation

If you are having trouble generating PDF files, try the following procedures:

1. Enable logging by setting HKLM\Software\BigFix\Enterprise
Server\BESReports\PDFLogPath [REG_SZ] to "C:\webreportspdf.log". Note that this is
unnecessary in 7.1, because logging goes to the debug log.

2. Verify that the server machine has been restarted after performing the installation.

3. Verify that the registry values under the HKLM\Software\BigFix\Enterprise
Server\BESReports key are correct:

e PDFEnable: 1

e PDFPostScriptPath should be equal to the port of the printer added during the
installation.

o PDFPrinterName should be equal to the name of the printer added during the installation.

If charts do not appear in the generated PDF, ensure that Internet Explorer, running under the
SYSTEM account on the Web Reports server box, has the correct security settings to render
Web Reports pages. Using the "at" or the "schtasks" command, bring up Internet Explorer.
Navigate to the Web Reports Overview page and verify that the charts show up. If not, you need
to change your security settings to allow ActiveX plugins and JavaScript.
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Blank Report

This report lets you name, describe and categorize a custom report. A report like this is actually
code that generates a printable report. It typically consists of HTML with embedded Relevance
commands. You can choose to make this report public or private. For more information on
creating a custom Blank Report, see the Advanced Topics section at the end of this guide.

To create a custom report:

1. Select Create > Blank Report. Click Next. The following screen will appear:

Store Report

Report Name:l -
{ max size: 100 characters )

Description:

{ max size: 1000 characters )

Category: |Unkn0wn

" Public

Visihility: & Private

Report:

Kl L
Store Report |

2. Fill in the following sections:

a. The Report Name, as it will be displayed in the report list.
b. A short Description of the report.

c. A Category for the report. Category names are typically short, descriptive titles, like
Action Summary, Computer Properties or Relevant Fixlet messages.

3. Click one of the buttons to make the report Public or Private. A Public report is available to
be viewed by all BigFix Operators, and it will include your name as creator. A Private report is
available only to you in the My Reports section.

4. Paste a copy of the report in the large text box labeled Report. This will add your custom
report to the list of available reports.
Use the Current Report box in the left panel to Filter, Configure, Store, Export, Print, or Email

this report.
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HTTPS Configuration

To provide more security to Web Reports, you can use HTTPS. First, you need to request a
Secure Socket Layer (SSL) certificate from a vendor such as Verisign, and then you need to set a

registry key with the location.

To register a certificate, you need a valid configuration file. It should look like this example:

[ req ]
default bits = 1024
default_keyfile = keyfile._pem

distinguished_name = reqg_distinguished_name

attributes = req_attributes
prompt = no
output_password = mypasswrd

[ req_distinguished_name ]

C = US

ST = California
L = City

0 = BigCo

OU = Development
CN = Common

emai lAddress = janedoe@bigco.com

[ req_attributes ]
challengePassword = bigcopasswrd

To use HTTPS:

1. Install Open SSL.

2. Save your configuration file as something like mynewconfig.conf, and issue your certificate
request. This will also generate a private key (in the file named keyfile.pem). Use this

command:

openssl req - new -config "c:\mynewconfig.conf" > cert.csr

3. Remove the password from your private key file:

openssl rsa -in keyfile.pem -out nopwdkey.pem

4. Create a certificate file:

openssl x509 -in cert.csr -out cert.pem -req -signkey nopwdkey.pem -days 365

5. Open up nopwdkey.pem in a text viewer, copy the contents, and paste them below the

certificate in cert.pem.

6. Save this file; it is your SSL certificate.
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Next, you need to store the path for this file in the registry and add or modify three sub-keys: one
for the HTTPS flag, one for the location of the SSL certificate, and one for the HTTPS port
number.

7. Run Regedit and find the HKey Local Machine\Software\BigFix\Enterprise
Client\Settings\Client key.

8. Create a new sub-key of “Client” called _WebReports_HTTPServer_UseSSLFlag. If the key
already exists, do not create a second one.

9. Create a new string value (reg_sz) for the key _WebReports_ HTTPServer_UseSSLFlag
called “value” and set it to 1 to enable HTTPS.

10. Create a new sub-key of “Client” called _WebReports HTTPServer_SSL CertificateFilePath.
If the key already exists, do not create a second one.

11. Create a new string value (reg_sz) for the key
_WebReports_ HTTPServer_SSL CertificateFilePath called “value” and set it to the full path
name of the SSL certificate (cert.perm).

12. Create a new sub-key of “Client” called _WebReportsHTTPServer_PortNumber. If the key
already exists, do not create a second one.

13. Create a new string value (reg_sz) for the key _WebReportsHTTPServer_PortNumber called
“value” and set it to the port number you would like to use (typically 443).

14. Restart the BESWebReports service.

15. Edit any entries in the AGGREGATEDBY table in the bfenterprise database to reference the
Web Reports URL using the https:// prefix instead of http://.

The SSL certificate should be in standard OpenSSL PKCS7 (.pem) file format. If the certificate
meets all of the trust requirements of the connecting browser, then the browser will connect
without any intervention. If the certificate does not meet the trust requirements of the browser,
then you will be prompted with a dialog asking if it is OK to proceed with the connection, and
giving you access to information about the certificate.

Typically, a trusted certificate is one that is signed by a trusted authority (e.g. Verisign), contains
the correct host name, and is not expired. The .pem file is your SSL certificate, which you must
obtain through your favorite CA. If you do not require authentication back to a trusted root, you
can also generate a self-signed certificate using OpenSSL utilities.
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Logging Web Reports

Setting up a log file can help you should you need to debug your installation of Web Reports. The
name of the log file is stored in the registry.

To specify the file location:

1. Run Regedit and find the HKey Local Machine\Software\BigFix\Enterprise
Server\BESReports key (on a 64-bit machine, you may need to dig down into the
Wow6432Node).

You will see some variables and pathnames used by Web Reports. You need to add two values
to this key: one for the logging flag, and one for the filename.

2. Create a new DWORD value named LogOn and set it to 1 to turn on logging.

3. Create a new string value named LogPath and set it to the full pathname of your desired log
file, e.g. “C: \fullpath\file.txt".

The next time you launch Web Reports, a log of the session will be saved to the specified file.

Querying Using HTTP GET

You can query and access Web Reports by using HTTP GET. Given the URL and port for the
Web Reports program, pass the desired command in your browser address line. If you are
already logged in to the program, you can access the main page with a URL:

http://bigco.com:52312/webreports?page=Main

In this example, bigco.com is your domain, 52312 is the default BES port, and page=Main
describes the part of the program you wish to access. If you have not yet logged in, you can pass
your Username and Password on the same line:

http://bigco.com:52312/webreports?Username=myName&Password=myPassword&page=Main

In addition to accessing various pages in the program, you can also evaluate relevance
expressions by accessing a special page labeled EvaluateRelevanceOnly:

http://bigco.com:52312/webreports?page=EvaluateRelevanceOnly
&expr=number%200f%20BES%20Computers

User's Guide 70 Copyright © 2009 BigFix, Inc.



BigFix® Web Reports

The relevance expression to evaluate here is expr=<relevance expression>. When passing
information in a URL, you need to use URI encoding. Web Reports evaluates the expression and
returns the answer as a snippet of XML:

<?xml version="1.0" ?>
<RelevanceEvaluationXML>
<answerlist>
<plurality>0</plurality>
<answer>37945</answer>

</answerlist>

</RelevanceEvaluationXML>

In this example, Web Reports indicates that there is only one answer (plurality=0) and that
answer is 37,945—the number of computers in this installation. If you wanted to return a list of
computers in the same installation, the plurality would be “1” and there would be a computer
name inside each of 37,945 Answer tags.

Querying Using SOAP

You can also access Web Reports using SOAP. Most client libraries require the location of a Web
Services Description Language (WSDL) file and method name and parameters to pass into the
method. The WSDL file describes the network endpoints required to query the BigFix Database
through Web Reports. You can find a sample file, relevance.wsdl, in the BigFix installation
directory. This WSDL file defines relevanceExpr, which allows you to evaluate a relevance
expression. If you installed BigFix to a folder named BigFix Enterprise, you would find the file in
this directory:

BigFix Enterprise\BES Server\BESReportsServer\wwwroot\soap

The Registry contains the actual location for your particular installation:
HKLM\SOFTWARE\BigFix\Enterprise Server\BESReports\Paths

This registry key has a string value named wsdl that contains the pathname for the WSDL file.
The request includes a tag labeled relevanceExpr that contains the relevance expression

number of BES computers. This is one of the operations defined in the relevance.wsdl file.
Currently the only method that can be called is:

GetRelevanceResult( String relevanceExpression, String username, String
password )
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PERL

PERL code using the SOAP::Lite module that takes three arguments, Web Reports username,
password, and relevance expression and prints the results of the call.

use SOAP::Lite;

#arguments: [hostname] [username] [password] [relevance expression]

#hostname only, e.g. “"example.com® rather than "http://example.com/webreports”

my $host = $ARGV[O];

my $username = SOAP::Data->name(“username” => $ARGV[1] );

my $password = SOAP::Data->name(~password” => $ARGV[2] );

my $expr = SOAP::Data->name("relevanceExpr® => $ARGV[3] );

my $service = SOAP::Lite -> uri( "http://" . $host . "/webreports?wsdl” )
-> proxy( $host );

my $result = $service -> GetRelevanceResult( $expr, $username, $password );

if( $result->Fault ) {

print "faultcode: " . $result->faultcode . "\n";
print "faultstring: " . $result->faultstring . "\n";
}
else {
c foreach my $answer ( $result->valueof( "//GetRelevanceResultResponse/a™ ) )
print $answer . "\n";
}
}
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Raw SOAP Request and Response Format

A SOAP request looks like:

<?xml version="1.0" encoding="UTF-8"7?>
<env:Envelope xmlns:env="http://schemas.xmlsoap.org/soap/envelope/” >
<env:Body>

<GetRelevanceResult
xmIns="http://[webreportshostname] : [webreportsport]/webreports?wsdl'>

<relevanceExpr>names of bes computers</relevanceExpr>
<username>bigfix</username>
<password>bigfix</password>
</GetRelevanceResult>
</env:Body>

</env:Envelope>

A SOAP response looks like:

<?xml version="1.0" encoding="UTF-8"7?>
<env:Envelope xmlns:env="http://schemas.xmlsoap.org/soap/envelope/'>
<env:Body>

<GetRelevanceResultResponse
"xmIns=http://[webreportshostname]: [webreportsport]/webreports?wsdl’>

<a>Computer 1</a>
<a>Computer 2</a>
<a>Computer 3</a>
</GetRelevanceResul tResponse>
</env:Body>

</env:Envelope>

Sample relevance expressions are available at the BigFix web site (www.bigfix.com). You can
also consult your BigFix representative for more information.
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Session Inspectors

BigFix Console and BigFix Web Reports both depend on an in-memory session cache to provide
an efficient view of your BigFix database. Due to their distinct environments, these two programs
have some significant differences:

BigFix Console BigFix Web Reports

Does not maintain Fixlet History inspectors.  Maintain Fixlet History inspectors.

Current inspectors are designed to work in  Current inspectors do not work.
the BigFix Console only.

Inspectors dealing with globally visible Locally visible Fixlet messages return nothing.

Fixlets are consistent across applications.

Works with only one BigFix Server. Works across multiple BigFix Servers.

JavaScript EvaluateRelevance calls are JavaScript EvaluateRelevance calls generate an

instantaneous. HTTP request, which incurs a round-trip penalty
to the server.

Links to Fixlet filters, computer groups, Links to Fixlet filters and computer groups do not

computers, Fixlets, tasks, and analyses work. Links to computers, Fixlets, tasks, and

work. analyses work.

Displaying Web Reports from Content Sites

Web Reports accepts a report format that can display reports from content sites, allowing new
reports to be added, edited, or removed by Fixlet actions or Tasks. There are three basic report
types: External, Template and Custom. The report file must be a valid XML file with an
extension of .beswrpt.

The Name and Category tags correspond to the same-named columns in Report listings. The
contents of the Description tag pop up when you click the help link [?] next to each individual
report in the list. If these fields are left blank, Web Reports supplies a suitable default, depending
on the type of the report. You cannot have a blank category tag.

The Source field indicates the author of the report.
The contents and the existence of the URLParameters and Data tags depend on the Type tag.

The Type tag can be one of three case-sensitive strings: TemplateReport, CustomReport, or
ExternalReport.
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The .beswrpt file can also contain multiple reports in a single XML file:

<BESWebReports>
<BESWebReport>

</BESWebReport>
<BESWebReport>

</BESWebReport>
</BESWebReports>

External Reports

An External Report contains a URL pointing to another page, service or reporting engine. The
report file is a simple wrapper containing the full URL of the destination. When you import an
External Report, it appears in the Web Reports list like any other report. When you click on an
External Report, it loads the target page into the browser.

In this example, an External Report loads the BigFix home page:

<BESWebReport>
<Name>Example External Report</Name>
<Description>
BigFix Home Page
</Description>
<Type>ExternalReport</Type>
<Category>External Report</Category>
<Source>BigFix, Inc.</Source>
<Data>
http://
</Data>
</BESWebReport>

Note:  An embedded URL is an absolute address and must start with http:// or https://
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Custom Reports

You can create a Custom Report using HTML with JavaScript and embedded Relevance
expressions. The Data tag contains the full report request in a character data (CDATA) block.
The XML parser will not attempt to interpret a CDATA block as markup, so you do not have to
escape your included HTML or JavaScript.

The optional URLParameters tag can contain extra information for Web Reports to use, such as
filters or CSV format. The entire parameter set is beyond the scope of this document. For more
information see the BigFix Knowledge Base.

A custom web report has the form:

<BESWebReport>
<Name>Example Custom Report</Name>
<Description>
A customized report, prints all computer names.
</Description>
<Type>CustomReport</Type>
<Category>Custom Report</Category>
<Source>BigFix, Inc.</Source>
<Data>
<I[CDATA[
<div>Computer Names</div>
<?Relevance names of bes computers?>
11>
</Data>
</BESWebReport>

To override the title <div> tag in a Custom Report, use the following:

var titleDiv = document.getElementByld( "wr_titlediv® );

titleDiv.className = "my title class”;

titleDiv.innerHTML = "my new title”;

If you wish to add your own onload events, make sure you call the original Web Reports onload
event afterward. For example, if you wish to invoke an hourglass, retrieval and pointer event
when your custom page is loaded write:

window.onload = function() { hourglass(document._body);
RetrieveData(); pointer (document.body); }
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However, the previous example would overwrite the necessary default event to start up Web
Reports. To avoid that problem, save the original event and add it to the end of your function list:

var oldonload = window.onload;

window.onload = function() { hourglass(document._body);
RetrieveData(); pointer(document.body); oldonload(); }

This will ensure that the Web Reports Ul shows up correctly.
Template Reports

A Template Report is similar to an External Report, except that the base of the URL is assumed
to be the Web Reports server. These reports are essentially the same as the native Web Reports.
The information in this section is included for completeness; in general you will only need to use
Custom or External reports.

The Data tag does not exist for this report. Instead, it passes all its information in the
URLParameters tag.

For example, you might create this Issue Assessment report:

<BESWebReport>
<Name>Example Issue Assessment Report</Name>
<Description>

An example report. Runs the Issue Assessment report with specific
Fixlets, BES Support/129 and BES Support/173.

</Description>
<Type>TemplateReport</Type>
<Category>lssue Assessment</Category>
<Source>BigFix, Inc.</Source>
<URLParameters>

FixletParam=BES Support%2f129&amp;FixletParam=BES
Support%2f173&amp ; page=VAReport

</URLParameters>

</BESWebReport>

In XML as in HTML, you need to escape the URL Parameter.
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Global Support

BigFix offers a suite of support options to help optimize your user-experience and success with
this product. Here’s how it works:

° First, check the BigFix website Documentation page:

° Next, search the BigFix Knowledge Base for applicable articles on your topic:

° Then check the User Forum for discussion threads and community-based support:

If you still can’t find the answer you need, contact BigFix’s support team for technical assistance:

(] Phone/US: 866 752-6208 (United States)
(] Phone/International: 661 367-2202 (International)

° Email: enterprisesupport@bigfix.com
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